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Introduction and Workflow

Introduction

Trimble WorksOS, a new cloud-based operating system and application, integrates data
from many providers to deliver 3D productivity and real-time progress-to-plan data for site
supervisors and project managers to maximize jobsite efficiency.

We're forging new ground so you can control your entire construction project while making
every working hour more efficient. Simultaneously, stay three steps ahead with
comprehensive real-time data to make construction management easier on and off the job
site.

WorksOS is easy to use and will increase your team'’s productivity, even if you are not a
surveyor! As a Trimble machine control customer, you have already seen the benefits of
your machine control system.

WorksOS integrates with Trimble Business Center, Trimble WorksManager,

Trimble Siteworks, Trimble Earthworks Grade Control, and Trimble PULSE Fleet and
Equipment Management Software to bring next-generation, real-time visibility to the
construction site.

WorksOS is the central ‘operating system’ that connects inputs from multiple sources to
provide Progress, Productivity, and Quality, and Cost (PPQC) information to Site
Supervisors and Project Managers:

e Use one ‘central’ application for monitoring a civil construction job site

e Connect back to existing Trimble apps that contain more details

A
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Manager
Prerequisites
e Trimble Identity (TID) credentials (username and password); create a new TID here
e WorksOS license; contact your SITECH dealer
e WorksOS account
e Account, users, and devices setup in WorksManager
Note: Your ability to create, edit, and delete accounts, projects, users, and content
in WorksOS and WorksManager depends on your role and permissions:
Account Roles
e Administrator - Account Admins can see and do everything needed to
manage an account.
e User - Account Users can see some things in an account, but cannot
change anything.
For details, see the Account Roles help topic.
Project Permissions
e Manager - Project Managers can see and do everything needed to manage
a project.
e Viewer - Project Viewers can see some things in a project, but have limited
abilities to change them.
For details, see the Project Permissions help topic.
To change your account role or project permissions, contact your Account
Administrator.
b, .
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https://identity.trimble.com/trimble-identity/identity/anonymoususers/usersignup?sp=Worksmanager&lang=en&application=Worksmanager&ckj=eyJ4NXQiOiJNREk0WTJNd1pUVmpNRGRsTkdVeFlUSmtaV00zWmpCaVptVTBZVFprTkRjek9HTmhZMk5oTmciLCJraWQiOiJNREk0WTJNd1pUVmpNRGRsTkdVeFlUSmtaV00zWmpCaVptVTBZVFprTkRjek9HTmhZMk5oTmciLCJhbGciOiJSUzI1NiJ9.eyJpc3MiOiJodHRwczpcL1wvaWRlbnRpdHkudHJpbWJsZS5jb20iLCJ0eXAiOiJ1cm46aWV0ZjpwYXJhbXM6b2F1dGg6dG9rZW4tdHlwZTpzZWN1cmVfcGFyYW1zIiwiZXhwIjoxNTgxMzYxNDgxLCJpYXQiOjE1ODEzNTc4ODEsImNsaWVudF9pZCI6IlZwSE9EY2tENnpQYVgxRG4zbnBRbks3UEpTNGEifQ.QPL2eWJsXHKEyA7ksmUESOmw5fzROGhHeBQXYdX4JJfdiBmFZ7jyOGssEW5__BVpe6bsfXJ7xhe7qogqEsBoiymTrSb58BB0JydBaFt-t8-daWeusjFkm9j-8DTebs59c8DlxYUKkrRyBEQVChKspJr6d8j8SkPvAN5ZMbtTGRU
https://construction.trimble.com/where-to-buy
https://community.trimble.com/viewdocument/account-roles?CommunityKey=d7710c73-a90f-4390-b398-b8d3e28e5c44&tab=librarydocuments
https://community.trimble.com/viewdocument/project-permissions?CommunityKey=d7710c73-a90f-4390-b398-b8d3e28e5c44&tab=librarydocuments

Required Data

Coordinate system/site calibration
Georeferenced project site
Machine data

Alignments or linework

Site surveys

Design surfaces

Supporting Info

This guide includes numbered steps, as well as supporting information formatted like this:

Boxes like this contain supplemental text about the steps you are working through.

You can skip over the information in these boxes if you just want to work through the
procedures. For in-depth, conceptual information, you should (of course) press F1 to
see the context-sensitive help.

Recommendation

Use two side-by-side monitors to be more productive; switch back-and-forth between this
guide on one screen and WorksOS on the second. Alternately, you may find it easier to
print this document so that you can maximize the program on your monitor. Working from
a printed copy may mitigate focus issues when switching between a PDF document and the
application.

TRANSFORMING THE WAY THE WORLD WORKS P@;bTri mble
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Workflow Overview

1. Using your machine control system’s GPS/GNSS data, WorksOS accurately maps the

locations and elevations of every place your machines work within your project’s
boundaries.

614
612
610
608
606
604
602
600
598

2. From that data, you can ‘create’ an as-built surface, which is the last pass of a
machine creating the final surface of the day. This is done by refining the raw
machine surface in WorksQOS to create a more finished (i.e., filtered) version. The
ability to refine an existing as-built surface is the power of WorkOS; they convert raw

data into something you can use to plan. Filters provide you surfaces for specific
dates (filter), machines (filter), and design/area/alignment (filter), etc.

e

As Built Surface

TRANSFORMING THE WAY THE WORLD WORKS
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3. Now you can compare that last as-built surface to a previous as-built surface.

Previous As Built Surface
4__—!“\

As Built Surface

4. Based on the change/difference between the two surfaces, you can calculate
volumes.

Previous As Built Surface

Volume Calculations

As Built Surface
5. Anywhere the elevation of the design surface is below the current surface is ‘in cut’;

anywhere the design is above the existing is ‘in fill', so you can also create cut/fill
maps.

Previous As Built Surface

Volume Calculations

-

As Built Surface

6. In addition, you can compare the as-built surface to the original ground surface
from a survey. This volume comparison tells you how much work has been done

Ph 1
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since the original survey.

As Built Surface Volume Comparisons

How much since Survey?

7. You can also import design surfaces from Trimble Business Center (TBC) to help
determine how much work remains to achieve the design.

Volume Comparisons

As Built Surfacg

B Trimble. Finish Grade Design

8. Ifyou also pull in linework and geofences from TBC, and compare them to the finish
grade design, this will tell you how much work is remaining to complete.

9. To see all of your cut/fill, compaction, and other data in one place, visit your
configurable Dashboard where you can set up various widgets for a quick look at
the movement of material, work completed since the initial survey, and work
remaining to get to the finish grade.

= dBTrimble WorksOS LI ]
+2 First Shared Da... +2 New Share &% Zone Section 1 Section 2 +2 section 3 Daily Work Complet... North Parking Lot D... Whi > :‘_ﬁ e
From Last Survey =0 ; Work Remaining Overall =0 ; Section 3 Last Week =0 ;
Progress from first to latest surface for selected pe. Progress from latest surface to design for selected perioc Progress from first to latest surface for selected pe.

13,9477

Fill Remaining

-9,202.1(m 34,1761

Deficc Total Volume

-9,202.1(m 34,176.1

Defiic Total Volume

Last Updated: 03/07/22 09:50 AM Last Updated: 03/07/22 09:50 AM

Section 3 Today =0 ; Section 3 This Week =0 ;
Progress from latest surfat Progress from latest surface to design

ce to design for selected rom latest surface to design for selected

23,401.06m

Total Volume

Deficie

Last Updated: 03/07/22 09:50 AM Last Updated: 03/07/22 09:50 AM Last Updated: 03/07/22 09:50 AM

When you have questions, your best source of help is the WorksOS Resource Center.

h:“h 1
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https://community.trimble.com/community/find-answers/civil-engineering-and-construction/worksos

Account Roles and Their Functions

Overview of Roles and Permissions

Account Level
At the account level, there are two roles that enable different functions within WorksOS:

e Account Administrator
e Account User

Here is a simple view of the functions for each role:

WorksOS Function Administrator User

Projects Create, archive View
(All other project functions should be done by Project
Managers at the project level. See Project Permissions.)

Account Users Add to account, edit (reassign role), delete from -
account
(All account user functions should be done by Project
Managers at the project level. See Project Permissions.)

Note: Many Account Roles and Project Permissions are shared with WorksManager too.

Project Level

At the project level, there are two permission levels that enable different functions:
e Project Manager
e Project Viewer

For details, see the Project Permissions help topic. To change your account role or project
permissions, contact your Account Administrator.

Demote current Account Admins to the Account User role

1. Log in to WorksOS with your admin credentials.

2. Choose an account in the Account Selection list, and click Apply.

- \ 2 Trd
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https://community.trimble.com/viewdocument/project-permissions?CommunityKey=d7710c73-a90f-4390-b398-b8d3e28e5c44&tab=librarydocuments
https://community.trimble.com/viewdocument/account-roles-1?CommunityKey=05542456-e9ac-43c3-abc8-9e70405a464d&tab=librarydocuments
https://community.trimble.com/viewdocument/project-permissions-1?CommunityKey=05542456-e9ac-43c3-abc8-9e70405a464d&tab=librarydocuments
https://community.trimble.com/viewdocument/project-permissions?CommunityKey=d7710c73-a90f-4390-b398-b8d3e28e5c44&tab=librarydocuments

3. Inthe left pane, click the E Account Users icon.

4. Search for and check the box next to one or more users who have Admin rights that
you want to convert to the Account User role.

L

5. Clickthe * Actions menu icon and select Edit Users. For a single user, you can also

>
just select the row and click the / Editicon.

6. Select User in the Account Role list.

Edit User Info X
User Email

E % david_kosakowski+accountuser@trimble.com
Account Role (3

Edit Users
User

Admin @

Invite Users to Project

Delete Users

7. Click Save.

Once a user is demoted from Account Admin to Account User, they are project
focused. User changes you make in WorksOS will appear in WorksManager too as
the two apps share users.

Note: You can multi-select and change roles for many users at once.
Note: You cannot delete your own user account; only another Admin can.

Add Account Users

1. Login to WorksOS with your admin credentials.

2. Choose an account in the Account Selection list, and click Apply.

3. Inthe left pane, click the E Account Users icon.

4. In the upper right, click the Add button.

5. Inthe Invite Users pane, select User in the Account Role list.

- . 2 Trd
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6. Enter the user's email address (the one used for their Trimble Identity (TID) account).

7. Click INVITE and then Save.

Manage Projects

Review an Existing Project

Accounts and projects are shared between WorksManager and WorksOS so that when an
Account Administrator creates a project in one application, it is visible and accessible in the
other app.

This connection between WorksManager and WorksOS also applies when the Admin shares
projects with other users in your account. If you create a project in WorksOS, other users
you have shared with will automatically have access and administrative rights, without
needing to go into WorksManager. A project is ready for use in WorksOS once it is created
in WorksManager.

Note: Currently, all additional user management, such as adding/removing users to/from
projects, is done in WorksManager. See the WorksManager documents here for more

information. Only additional users (who did not create the project) need to be added to a
project in WorksManager.

G Y, (R4 1
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1. Go to https://worksos.trimble.com/app/ and sign in to your Trimble Identity (TID)
account.

& Trimble

Sign in to WorksOS

Sign in

Stay signed in Forgot password?

Create new Trimble ID

2. Select your account (as previously set up in WorksManager) and click Apply.

Note: If you have many accounts, type any part of the name in the Search field.

BTrimble WorksOS 0

Account Selection

Logged in as

TRIMBLE WORKSOS DEMO 1 @

Clear | Apply

x
S
=
@
)
]
&

You will see tabs for three types of projects:
o 3D-enabled - a project intended to have machine productivity (.tag file) data
processed into it. 3D-enabled type projects are used primarily in WorksQS,
but still have full project functionality in WorksManager.

s -
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o Non-3D-enabled - a project (also known as 2D-enabled) that is not intended
to have machine productivity (.tag file) data processed into it. It will still have
full project functionality in WorksManager and will primarily be used there.

o Archived - a completed project (of either type) in either WorksOS or
WorksManager that has been ‘shelved’ as a record of the work that was done.
The archived state is reflected in both applications.

These are all projects you have been given access to (or created), including all

projects for this account in WorksManager. For more information, see Creating,
Editing, and Archiving Projects.

= dBTrimble WorksOS Trimble Westminster Project F - )
30 Enabled (1) Non 30 Enabled (0) Archived (0) Q m
L 4
Trimble Westmin...
3D Enabled
ks
N H
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Project Permissions and Their Functions

Overview of Permissions and Functions

Project Level

At the project level, there are two permission levels that enable different functions:

e Project Manager

e Project Viewer

Here is a simple view of the functions for each permission level:

WorksOS Feature Manager Viewer

Projects Create, view, edit, archive View

Dashboards View, view shared, add, edit, share,  View, view shared
delete, add/reorder widgets

Map View, change map type, Profile, View, change map type,

Project Members

Filters

Reports

Imports

Exports

TBC Sync

Project Settings

Custom Area, DDV

View, invite to project, edit (reassign
role), remove from project

View, edit, apply, remove

Set parameters, generate, download
(view in Microsoft Excel)

Import files, view, delete, connect to
external apps for import

Set parameters, export

Publish from Trimble Business Center
(TBC)

View, edit

Profile, Custom Area, DDV

View

(limited to filtering by
Dashboard widgets)

Set parameters, generate,
download
(view in Excel)

View

Set parameters, export

View, edit

For WorksQOS account-level roles, see Account Roles. To change your account role or project
permissions, contact your Account Administrator.

WorksOS - User Guide
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Note: Many Account Roles and Project Permissions are shared with WorksManager too.

Invite a User to a Project

1. In the left pane, click the E Projects icon.

2. Click 3D Enabled, Non 3D Enabled, or Archived to show the right set of projects.

= ¢BTrimble WorksOS

3D Enabled (0) MNon 3D Enabled (10) Archived (0)
e
p—
My jobsite Existing job site Old Job Site 2
Mon 3D Enabled Non 3D Enabled Non 3D Enabled

-

3. Click a project tile (...or click the * More icon and select View Project Members).

4. In the upper right, click the INVITE button.

5. Inthe Invite Members pane, select a role in the Project Role list.

6. Enter the user's email address (the one used for their Trimble Identity (TID) account).

7. Alternately, you can click the + icon next to existing users to invite them.
Bharathiselvan +
Charlie
Dan

Jeeva

+ + + +

Jeff

8. Click NEXT.

s -
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Create, Edit, and Archive Projects

Creating Projects

Accounts and projects are shared between Trimble WorksManager and Trimble WorksOS
so that when you create a project in one application, it is visible and accessible in the other
app. A project will be ready for use in WorksOS once it is created in WorksManager.

This connection between WorksManager and WorksOS also applies when you share
projects with other users in your account. If you create a project in WorksOS, other users
you have shared with will automatically have access and administrative rights, without
needing to go to WorksManager.

Note: Currently, all user management, such as adding/removing users to/from projects,
is done in WorksManager. See articles in the Learning Guides section of the

WorksManager Resource Center for more information. Additional users (who did not
create the project) need to be added to a project in WorksManager.
Note: A project created in WorksManager is ready to use in WorksOS once you have

changed it to 3D-enabled.

Create a project

1. Open worksos.trimble.com/app.
2. Select your account, and click Apply.
a. Click your Profile icon and select Preferences.

.Lom

Account Selection

) B @ o
Logout

b. Set preferences for:
i. Date and time formats and the time zone (of the project location)
i.  Location display and WorksOS interface language
iii.  Units for measure (distance), pressure, temperature, and number

(¥
'

8]
n)

format

- 2 Trd
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iv.  Currency for cost data

c. Click Save.
3. Click the Create button.

a. Click the Create button in the upper right corner.

4. Inthe Create New Project pane > PROJECT INFO tab:

a. Confirm your account or select a different one to create the project in (this is
the same account used for WorksManager).

b. Enter a Project Name; this must be unique among all projects in the selected

account.
Create New Project X
PROJECT INFO CONFIG FILES

PROJECT INFORMATION

TRIMBLE WORKSOS DEMO 1

Rosemount Landfill

i.  Confirm your account or select a different one to create the project in
(this is the same account used for WorksManager).

ii.  Enter a Project Name; this must be unique among all projects in the
selected account.

5. select the Project Type. There are 2 types of projects.

e 3D Enabled - this a project that is intended to have machine productivity
(.tag file) data processed into it. 3D-enabled type projects are used primarily
in WorksOS, but still have full project functionality in WorksManager.

e Non-3D-enabled - this is a project that is not intended to have machine
productivity (.tag file) data processed into it. It will still have full project
functionality and will primarily be used there.

L+, L]
TRANSFORMING THE WAY THE WORLD WORKS & Trimble.

WorksOS - User Guide 20



6. Click NEXT and select either 3D-enabled or Non-3D-enabled in the Project Type list.

Project Type X

a. Click NEXT and then FINISH on the bottom right toolbar to complete the new
project setup. At this point, these project attributes are validated; if any fails,
the project is not created:

Project name is unique for the account
Project calibration (coordinate system) file is valid

7. Click Next to proceed to the CONFIG FILES tab.
a. Click + next to Calibration .dc .cal., browse to a coordinate system file for the
project.
i.  Click + next to Calibration .dc .cal. Browse to and add a coordinate
system/site calibration file for the project.

Note: Calibration files are mandatory for WorksOS 3D-enabled projects in
order for machine productivity data (.tag files) to be processed into the
project. To ensure data and location accuracy, the file should be the same
calibration file as the machines in the field are using.

Calibration files are required for WorksOS 3D-enabled projects in
order for machine productivity data (.tag files) to be processed into
the project. To ensure data and location accuracy, the file should be
the same calibration file as the machines in the field are using.

Note: WorksOS supports the Trimble Geodetic Library (TGL) for published
coordinate system definitions that have been added to the library. This
means that published shift grids and geoids contained within the TGL can
have their respective coordinate system definitions assigned to projects in
WorksOS. All project data should display and project correctly within the
project boundary. This feature does not include custom coordinate system

: \ 2 Trd
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definitions that are not part of TGL; using these will impact project data
accuracy and positioning.

Note: If you do not have a site calibration file during project creation, you
can always add one later to make the project 3D-enabled.

b. Typically, you will draw a project boundary in the next step, but you can
optionally upload the boundary for a project as a .dxf file. Click + next to
Boundary .dxf and browse to a .dxf with the boundary.

i. Optionally, add a boundary for the project as a DXF file. Click + next to
Boundary .dxf and browse to a .dxf that includes the boundary.

c. Then select the unit of measurement the DXF file was created in to ensure a

correct project location and projection on the map in WorksOS.

. Rosemount.dxf .
% : :
e dxf

DXF Unit of Measurement ~

U.S. Survey Foot

International Foot

Y

Note: A .dxf file containing multiple boundaries can be uploaded. Currently,
WorksOS automatically selects the first boundary it finds in the .dxf file. It is
recommended that you select a .dxf file containing a single boundary.

Metric

- 2 Trd
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@ Open « Create New Project x

™ » ThisPC » Desktop » TestData » Mass Haul Data ~ O Search Mass Haul Data »

PROJECT INFO CONFIG FILES
Organize ~ New folder Bz O @
[ This PC A Name . Date modified Type Size CONFIGURATION FILES

I Desktap [7] 264 M2PP Sites from DXF.def 27/06/2014 3:37PM  DXF File 3,840K8 Files can always be added after a

%] Documents project is created.

J Downloads

B Music Calibration

=] Pictures .dc .cal

B Videos

& Vedafone Smart V8 264 M2PP Sites from ... :

&5 Windows (C) A

= data (\\nzc-ap-fsv-03) (G:)
= prod (\\nzc-ap-fsv-03) (H:)

U.S. Survey Foot
= group (\\nzc-ap-fsv-04) (J:)

== dev (\\nzc-ap-fsv-03) (K2)

== source (\\nzc-ap-fev-03) (O™ You must have a calibration file selected to

enable a Boundary Polygon to be used as 3

File name: || | [oxFFie v Project Boundary.

Cancel m
8. Click Next to proceed to the DRAW BOUNDARY tab.

9. Pan and zoom into the location of the jobsite.

Note: All other project boundaries for the account will be visible on the map

during the boundary creation step so that you can see where they are when you
create a new boundary.

e 3D-enabled project boundaries are yellow
e Non-3D-enabled project boundaries are blue

10. Pick points in the Map view to draw a polygonal boundary representing the extents
of the site, and double-click to close the final segment.

s -
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You can edit an existing project boundary by clicking-and-dragging a point. If you
need to undo a point, click

the Undo icon.
- i

This boundary is used as a ‘geo-fence’ that determines whether your field devices
and machines are ‘on site'. The boundary must represent the true location of the
project and encapsulate all areas where machines are running with the intention of
having their data collected.

1. Pick points in the Map view to draw a polygonal boundary representing the
extents of the site, and double-click on the first point to close the boundary.
This boundary is used as a ‘geo-fence’ that determines whether your field
devices and machines are ‘on site'. The boundary must represent the true
location of the project and encapsulate all areas where machines are/will be
running with the intention of having their data collected.

If you uploaded a .dxf boundary in the previous CONFIG FILES step, the polygon it
contains is displayed on the map as the pre-selected project boundary. No further
steps are required. A .dxf boundary cannot be edited.

Note: Any data outside the project boundary will not be processed into the
project. The seed position in each piece (.tag file) of machine data determines
whether the data can or cannot be processed into the boundary.

" W
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Note: All other enabled project type boundaries for the account will be visible on
the map in the BOUNDARY step so that you know where they are when you create
a new project’s boundary. 3D-enabled project boundaries are yellow and
non-3D-enabled project boundaries are blue.

Note: 3D-enabled project boundaries cannot overlap one another to ensure
machine productivity data processes in the correct project. If you draw a
boundary that overlaps another 3D-enabled project, you are notified that there is
an overlap and you cannot finish creating the project. Non-3D-enabled project
boundaries can overlap any other boundary without issue.

Note: To ensure that machine productivity data processes in the correct
project, 3D-enabled project boundaries cannot overlap one another in
space and time. If you draw a boundary that overlaps another 3D-enabled
project, they will be given a prompt that there is an overlap and cannot
proceed to finish creating the Project.

However, non-3D-enabled project boundaries can overlap any other
boundary without issue, so you can have projects that overlap in time and
space as long as only one of them is 3D-enabled.

Note: If you are also a Trimble Business Center (TBC) user, you can also add the
appropriate data there instead. To do this, see Configure and Assign a
WorksManager Project for a Job Site in the TBC help. The project you just created
will appear in the Project list there.

a. Click the Dashboard icon on the left navigation bar.

11. Once you have drawn or uploaded a polygonal boundary from a .dxf file, you click
NEXT and then FINISH on the bottom right toolbar to complete the new project
setup. At this point, these project attributes are validated; if any fails, the project is
not created:

e Project name is unique for the account
e Project calibration (coordinate system) file is valid

Editing Projects

You can edit an existing WorksOS project as requirements, designs, or field conditions
change.

Edit a project

1. On the left navigation bar, click the Projects icon (1 below).

] "";:'}F ]
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2. On the project tile you want to edit, click the More icon (ellipses), and select Edit

Project (2).

| 3D Enabled (2) Non 3D Enabled (0) Archive
N
9 e ' b

Trimble Dimensions 2012 Trimble Westmin

3D Enabled 3D Enabled

Edit Project
S

Archive Project

BACK

3. Follow the Create Project workflow to edit your project (with exceptions). Not all
fields can be edited; you can edit only these aspects of an existing project:
a. Project name
b. Project boundary - either manually redraw for a drawn polygon or by
uploading a new .DXF File for a DXF Project Boundary.
c. Project coordinate system/site calibration file.

Note: Altering the calibration file can impact machine productivity data and
project files; changing your coordinate/calibration after your projectis in
progress is not recommended.

d. Project type - You can change the types of 3D-enabled and Non-3D-enabled
projects as long as there are no overlaps between the 3D-enabled project
boundaries. Machine Productivity Data (.tag Files) will be affected for
processing at the time of project change and will not retrospectively fix
already processed Machine Productivity Data files (.tag).

Archiving a Project

When you have completed a project (of any type) in either WorksOS or WorksManager,
archive it as a record of the work that was done. The archived state is reflected in both
applications. Once a project is archived:

e You can still view, interact with, report on, and export a project’s data.

- . 2 Trd
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It retains all the data and functionality as when it was active.
No new data of any kind, including Machine Productivity Data (.tag files), can be
added, so a project only should be archived when it is truly complete.

e Its boundary is no longer displayed on the map when creating a new project, so you
can use the same location for a new project’'s boundary.

Warning: Archiving a project in WorksManager has real world consequences. For
example, devices are unassigned and designs are removed, etc. You should only archive
a project once it is completely finished or if it is not needed at all. Once archived, a

project cannot be restored.

Archive a project

1. On the left navigation bar, click the Projects icon (1 below).
2. On the project tile you want to edit, click the More icon (ellipses), and select Archive

Project (2).

|| 3D Enabled (2) Non 3D Enabled (0) Archive

] mxl O

Trimble Dimensions 2012 Trimble Westmin

3D Enabled U enabled

Edit Project

Archive Project @
-

BACK

3. The project is moved to the Archived tab. Confirm that your project appears on the
Archived tab.

Delete a project

You can only archive a project in WorksOS, but it can be deleted in WorksManager if it is no
longer needed. Projects that have machine data can only be archived.

TRANSFORMING THE WAY THE WORLD WORKS @*Tl‘i mble
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Review an Existing Project

Accounts and projects are shared between WorksManager and WorksOS so that when you
create a project in one application, it is visible and accessible in the other app.

This connection between WorksManager and WorksOS also applies when you share
projects with other users in your account. If you create a project in WorksOS, other users
you have shared with will automatically have access and administrative rights, without

needing to go into WorksManager. A project is ready for use in WorksOS once it is created
in WorksManager.

Note: Currently, all additional user management, such as adding/removing users to/from

projects, is done in WorksManager. See the WorksManager documents here for more
information. Only additional users (who did not create the project) need to be added to a
project in WorksManager.

1. Go to https://worksos.trimble.com/app/ and sign in to your Trimble Identity (TID)
account.

& Trimble

Sign in to WorksOS

Sign in

|_)5tay signed in Forgot password?

Create new Trimble ID

2. Select your account (as previously set up in WorksManager) and click Apply.

Note: If you have many accounts, type any part of the name in the Search field.

- 2 Trd
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https://community.trimble.com/community/find-answers/civil-engineering-and-construction/connected-construction
https://worksos.trimble.com/app/

B Trimble WorksOS # 0

Account Selection

Logged in as:

TRIMBLE WORKSOS DEMO 1 @

Clear | Apply

x
o]
4
=
2

You will see tabs for three types of projects:
o 3D-enabled - a project intended to have machine productivity (.tag file) data
processed into it. 3D-enabled type projects are used primarily in WorksQOS,
but still have full project functionality in WorksManager.

o Non-3D-enabled - a project (also known as 2D-enabled) that is not intended
to have machine productivity (.tag file) data processed into it. It will still have
full project functionality in WorksManager and will primarily be used there.

o Archived - a completed project (of either type) in either WorksOS or
WorksManager that has been ‘shelved’ as a record of the work that was done.
The archived state is reflected in both applications.

These are all projects you have been given access to (or created), including all
projects for this account in WorksManager. For more information, see Creating,
Editing, and Archiving Projects.

= dBTrimble WorksOS Trimble Westminster Project R )
3D Enabled (1) Non 3D Enabled (0) Archived (0) Q m
Trimble Westmin...
s
"
s : () 1
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3D-Enable a Non-3D-Enabled Project from WorksManager

To make a 2D-enabled project fully functional in WorksQOS, you need to 3D-enable it.
1. Click the Non-3D-Enabled tab and select the project.
2. Clickthe * More icon on the project tile and select Edit Project.

3. Click Next and confirm you have a .dc or .cal file attached in the Configuration
Files tab. If not, click + and add an applicable site calibration.

Note: A .dc or .cal site calibration file must exist in the project (added in
WorksManager) to 3D-enable it.

4. Click Next until you get to the Project Type pane.
5. Select 3D-Enabled in the list.
6. Click Next and Finish.

7. Wait a minute for the processing to complete and press F5 to refresh your screen.
You will now see the project in the 3D-Enabled list.

8. To continue reviewing and editing an existing project, select it to open the
Dashboard.

9. Review the Work Completed and Work Remaining volumes in the widgets.

10. To see the Map view, click either a widget tile or theﬂMap icon on the left side of
the screen.

= BTrimble WorksOS

Dashboard

Work Completed =0;

12,160.9w 2,704.0e

Cut Completed Fill Completed
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TRANSFORMING THE WAY THE WORLD WORKS @?Tﬂ mble

WorksOS - User Guide 30



11. Click the Metrics arrow/fly-out to access Quality Metrics. For more information
about map options, see this section.

= <BTrimble WorksOS

Project Extents 06/12/17 - 06/21/18

@ O

Metrics

)

12. Choose different metrics to review your project status. For more information, see
View Quality Metrics and Coordinates for a Cell below.

(] Project Extents 06/12/17 - 06/21/18

Quality Metrics X
9 Elevation @ =
Volume
Pass Count
CMV
MDP
Speed

1,667 M

FEEDBACK

1,660 M

@ Trimble
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Create, Edit, and Archive Projects

Manage Projects

Configure Project Settings

1. On the Actions bar, click the : More icon in the upper right, and select Settings >
Project. This can be done either before or after you create a project.

=0

Reorder Widgets
Dashboard »
Settings »
Imports

Help

The settings for whichever metric you have selected in the Map view are shown.

= & Trimble WorksOS Trimble Westminster Project HO0
Volume Pass Count v MDP Speed Temperature Elevation
CMV Summary CMV Percentage Change CMV Details

s~ o m O o
. s

FEEDBACK

2. Set preferences for:

" W
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o Volume - The amount of 3D space that a material occupies in cubic units.
Volume differences are calculated by comparing two surfaces to determine
how much material needs to be moved (cut and filled) during earthworks.

m  Cut/Fill - Settings for a map with shading and/or a grid of
measurements at an interval showing the elevation differences
between two surfaces, such as an original ground surface and a
design surface. Cut/fill maps are color-coded to indicate where earth
needs to be cut or filled.

e Default - Use preset values for cut, on grade, and fill values to
create a standard cut/fill map.

e Custom - Enter values for a specific use, such as:

o Excavation - Enter the highest and lowest elevations for
a design surface. When set, this will define the target
tolerances for your project for ALL devices.

o Landfill - Enter, for example, 2’ intervals for lifts.

m Bulkage/Shrinkage - During mass earthwork operations, earthen
materials, such as soils, occur in three fundamental density states,
each of which contractors need to recognize, account for, and convert
volumes between. Each of those density states represents specific
circumstances in which the material will be encountered or handled,
and for which its volume typically needs to be determined.

e Default - Set to this when you do not need to account for
material density states (or you do not have shrink/swell
percentages).

e Custom - Set material density percentages:

o Shrinkage - Calculate the shrinkage from cut or the
natural bed to fill. = (haul bulkage x haul compaction).
The decrease in volume of soil (or another material) due
to contraction, settling, and compaction. Also, a
measure of the decrease in volume of earth material as
it is excavated and extracted from its in situ state and
then placed into compacted earth fill. The expected
amount of shrinkage for a given soil can be expressed
as a percentage of the in situ soil volume (that of the
material in its natural state prior to excavation). For
example, a shrinkage factor of 9% indicates that the soil
will shrink to occupy a volume 9% smaller than it
occupied prior to its excavation.

o Bulkage - Calculate the bulkage from the natural bed to
the loose condition. = (shrinkage / haul compaction).
The increase in volume and decrease in density of soil
(or another material) due to expansion. Bulkage is a
common result when soil at its original in situ density is

: \ 2 Trd
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excavated from a job site and moved elsewhere during
construction activities.

Hanling Bulkage t T ik
— e ¥ Hauling Compaction
R CRi r
i Situr * Loose _T Bank Fill
_.- .-"" Haul . 5‘hﬂﬂkﬂEE _ S

Density States

o Pass Count - A measurement of the number of times that a machine (e.g.,
roller compactor) has traveled over an area on a surface.
m Pass Count Summary

e Default - Use preset targets of 2 - 8 passes.

e (Custom - Set specific counts when there are higher
requirements, such as a 4 pass minimum. When set, this will
define the target tolerances for your project for ALL devices.

m Pass Count Details

e Default - Use preset targets.

e Custom - Set specific values for the color-coded passes. When
set, this will define the target tolerances for your project for
ALL devices.

o Compacted meter value (CMV) - A measurement of the relative stiffness of
compacted material as measured by a sensor on a compactor.
m  CMV Summary
m  CMV Percentage Change
m  CMV Details
o Machine drive power (MDP) - Machine drive power values recorded by
compaction machine systems.
m Default - Use preset values.
m Custom - When set, this will define the target tolerances for your
project for ALL devices.
o Speed - Vehicle speed
m Default - Set to this when you do not need to account for speed.
m  Custom - When set, this will define the target tolerances for your
project for ALL devices.
o Temperature - A measurement of the heat of asphalt material laid and
compacted.
m Temperature Summary

L+, L]
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e Default - Set to this when you do not need to account for
temperature.

e Custom - When set, this will define the target tolerances for
your project for ALL devices.

m  Temperature Details

e Default - Set to this when you do not need to account for
temperature

e Custom - When set, this will define the target tolerances for
your project for ALL devices.

o Elevation - Vertical distance (height) above or below mean sea level. (2)
Vertical distance above or below the geoid. (3) Distance above or below a
local vertical datum.

m Default - Use preset values.

m  Custom - The highest and lowest elevations are populated and cannot
be edited. Select colors for elevation bands. When set, this will define
the target tolerances for your project for ALL devices.

3. Click Save when you are done.

Settings

The Project Settings page contains all of the project targets and thresholds and all of the
color settings that can be customized for the selected project. This feature simplifies
customizing project targets and colors in Dashboard widgets, on the map, and in reports.
e Project Targets determines the ranges displayed in Dashboard widgets and the Map
page.
e Project Colors lets you configure default or saved custom color settings for every
Quality Metric data type for use in the Dashboard widgets and the Map page.
Configuring project targets

You can override target values from Machine Default values with custom target values. For
example, you may need to increase the acceptable grade tolerance on this design. By
overriding the lowest cut tolerance for Cut/Fill data, you can easily see the changes for
grade data reflected on the map and in the Quality Metrics slider statistics.

Configure Project Settings, Map Colors, and Quality Targets

You can save your custom color selections in the color palette. This allows you to use your
saved colors for other quality metric data types without having to recreate a palette each
time. Saved colors are associated with user IDs and will be available for all projects
accessed by this user.

- \ 2 Trd
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1. On the Actions bar, click the * More icon and select Settings > Project. Settings for
whichever category you have selected in Map > Metrics appear by default.

2. Select one of the filter types (Volume - Elevation).
3. Select Custom.

4. Click a color to access the palette. Use the color picker to choose a new color for the
quality metric. You can pick a different hue for the current color in the swatch, use
the slider bar to choose a new color, or enter a color's Hex value, RGB value, or HSL

F

value (click the ¥ arrows to access the entry formats).

5. Make changes to target values as needed.

Note: To reset targets to machine defaults, before saving, select Actions bar /
Reset to Defaults.

6. Click Save. The Map and Dashboard legends update with the new colors and target
values. Elevations have five colors to configure, which when saved are turned into a
graduated color palette on the map.

Note: To reset colors to machine defaults, click the * More icon and select Reset to
Defaults. This has to be done while you are in the Project Settings page.

Configure Map Settings

You can control the types of files to display in the Map view. You can then use the Profile
tool to inspect a 2D cross-section of the work.

X

Map Settings
Alignments
Designs
Linework
Production Data

Cell Information

858 8 84

Devices

1. Click theﬂMap icon.

2. Inthe Actions bar *, select Settings > Map.
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3. Toggle data types on/off to show/hide them in the Map view:

e Alignments

e Designs

e Linework

e Production Data
(controls surveyed surfaces; you cannot toggle Custom Areas (i.e., geofences)
Cell Information (see below)
Devices

4. Click X to close the pane.

Note: To see selected quality metrics and coordinates for an individual cell, select
Cell Information. To see where the cells are located on the profile line, select Cell

Markers.
Ph -
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Manage Users

Manage Users

Add a User to a WorksOS Account

You can add one or more users to a WorksOS Account directly within the WorksOS
application.

Note: This operation can also still be completed for the same account and user in
Trimble WorksManager. Both applications have a common backend for accounts, users,
and projects, so settings for all of these aspects are mirrored in each application.

1. Click the “Users” icon in the left-hand side navigation bar.

B Trimble WorksOS

Users

List of users included in "Merino Alpha' account.

Mame Email

You are taken to the “Users” page which lists all existing users for the currently
selected account.

2. Click the blue “Add” button in the top right-hand corner.
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Q Searct

An “Invite Users” pane slides out from the right-hand side of the screen.

3. Begin typing the email address of the person you want to add to the account and
click the + button to add the email address to the list.

_ Invite Users » | Invite Users X
..... o in T i o a o o = o
USER EMAILS USER EMAILS
_ User Emails
SEr tmalis testemail@gmail.com| +
teste g C X

Note: You can add multiple users at once in this Ul by repeating the above step,
once for each user.

4. After you have added all desired user(s), click the blue Invite button. A notification
will appear in the bottom left corner of the screen, informing you an invitation has
been sent to that email address.
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The recipient should receive an email notification in their inbox that they have been
invited to an account (if not, suggest that they check their Junk Mail folders or email
security settings).

B Trimble WorksOS

Hi,

You have been invited by to join the
Trimble WorksOS account "Merino Alpha"

The invitee must click the “Join Account” link and login to WorkOS to actually gain
access to the account.

Note: The above steps only give a user access to an account; for access to a
specific Project, they must be invited to a project specifically. Please refer to the
section below.

Note: A user can also be deleted from an account by going to the same “Users”
page and checking the box next to their name. Click the More icon (ellipsis) and
choose Remove Member from Account.

Invite a User to a WorksOS Project

A user can also be added to a WorksOS Project inside the WorksOS application.

Note: This operation can also still be completed for the same account and user in
Trimble WorksManager. Both applications have a common backend for accounts, users,
and projects, so settings for all of these aspects are mirrored in each application.

- . 2 Trd
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There are two ways that a user can be added to a Project.

Ways You can Add a User to a Project

From the Users Page

Once a user has been added to an account in the Users Page, they can be added
straight to Projects by checking the box next to their name.

1. Click the More icon (ellipsis) and choose “Invite User to Project”.

An “Invite to Project” pane slides out from the right-hand side of the screen. All
existing 3D Enabled type projects for the entire account will be listed by name.

2. Check the selected Project(s) by name to add the user to.

Note: You can add a single user to a single project, a single user to multiple
projects, or multiple users to multiple projects using the above steps.

3. Once the project(s) are selected, click the blue “Next” button.
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_ Invite to Project > Invite to Project X

ALL PROJECTS SELECTED (1 ALL PROJECTS SELECTED (1)
c gse gre - & e salected
vite
PROJECTS PROJECTS
B Dimension 201 X

CANCEL NEXT ::-":“'\‘1 CEL IN‘U‘IITE

4. Once you have selected user(s) to become members for a project, click the blue
“Next” button. The selected users will be listed by email address now.

5. Click the blue “Invite” button and a notification will appear in the bottom left corner
of the screen informing you an invitation has been sent to that email address(es).

From the Projects Page

1. Find the intended project’'s thumbnail on the Projects Page, click the More icon
(ellipsis), and select “View Project Members".

" W
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Dimension 2012

3D Enabled

View Project Members

Edit Project

Archive Project

You are taken to the “Project Members” page which lists all existing users for the
selected project (thumbnail).

B Trimble WorksOS

Project Members

List of members included in 'Dimension 2012

[J  wame Email

2. To add a user, click the blue “Invite” button in the top right-hand corner.
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Q Search

An “Invite Members to XX Project” Ul slider will appear from the right hand side of
the screen. All existing users for the entire account will be listed by name.

3. Either click the + button to select an existing user from the list or, alternatively, type
their email address.

~ Invite Members to
' Dimension 2012 Project

CAMNCEL

Note: You can add multiple users at once by repeating the above steps, once for

each user.
Pn i
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4. Once you have selected user(s) to become members for a project, click the blue
“Next” button. The selected users will be listed by email address.

5. Click the blue “Invite” button and a notification will appear in the bottom left corner
of the screen informing you an invitation has been sent to the email address(es).

Once a user is invited to a project (using either method above), they should receive
an email notification in their inbox that they have been invited to an account (if not,
suggest that they check their Junk Mail folders or email security settings).

B Trimble WorksOS

Hi,

You have been invited by to join the
Trimble WorksOS project "Dimension 2012"

The invitee can click the “Sign In” link and login to WorkOS,; the Project will then be
available in the Projects page as a new thumbnail.

Note: A user must be invited to an account before they can be invited to a
project.

Note: A user can also be deleted from a Project by going to the “Project
Members” page, clicking the More icon (ellipsis), and selecting “Remove Member”.
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Remove Member
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Manage and Share Dashboards

Manage Dashboards

Dashboards and their filters are specific to each project.

Adding, Editing, and Deleting Dashboards

To do any of these things, click the * More icon in the upper right, and select Dashboard.
20
Reorder Widgets
Dashboard » 4« Dashboard

Imports Reorder

Edit

\l

A

Share

Delete

+  Add

Lﬂ Generate PDF

Edit - Allows you to change the dashboard name and description.
Share - See the next section below.
Delete - You are prompted to confirm, because you cannot undo or restore a
deleted dashboard

e Add - Enables you to create another dashboard that can optionally include the Work
Completed and/or Work Remaining widgets in small or large sizes, or to copy and
then modify an existing dashboard.

In any project, these things are accessible to the users or shared with them by default:
e Imported data

These things can be shared:
e Dashboards

These things are never shared:
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TRANSFORMING THE WAY THE WORLD WORKS & Trimble.

WorksOS - User Guide 47



e Your own unshared dashboards.
When you make a custom dashboard, you can now share it with colleagues in the same
project. When you receive a shared dashboard, you can

1. Select More > Dashboard > Add.
2. Modify the dashboard widgets.

Add Widgets x
B Work Complete

Work Completed

P From Tirse 1o |aness

f penod
ddael 5
(.:J Small
O Lar ge
] Work Remaining
Cancel Aod

3. Select More > Dashboard > Edit.

4. Inthe Name field, enter a name that will be easily identifiable when you share the
dashboard with colleagues. This name will not be editable by anyone but the creator
once the dashboard is shared.

Add and Configure Dashboard Widgets

1. In the Dashboard, click the°Add icon in the lower-right.
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2. Inthe Add Widgets pane, check boxes and select sizes for any of these widgets:
o Work Completed - Shows progress (in cubic meters/yards) from the earliest
ground surface to the latest surface for a selected period.
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o Work Remaining - Shows progress (in cubic meters/yards) from the latest
surface (or any in-progress) to a design surface for a selected period.

Add Widgets X

Work Completed

o from first to latest surface for

Widget Sizing

O small

Widget Sizing

O small
@ Large

Lnly ava able to view on tablet or

o Click Add. Add as many widgets as you need. You can customize the filters
that control what each shows using steps below.

= dBTrimble WorksOS Trimble Dimensions 2012 #oOO
Dashboard = [1] :
Work Completed =0; Work Remaining =0;
Progress from first to latest surface for selected period. Progress from latest surface to design for selected period.

2,003.31rrr’) 863.1(.“!: 2,003.3(m=J 863. 1 (m?)

Cut Completed Fill Completed Cut Completed Fill Completed

FEEDBACK

1,140.2 2,866.5 2,866.5(m

Surplus Total Volume Total Volume
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3. Edit any widget by clicking the * More icon in its upper right corner and selecting
the Custom option:

Change the type.

Enter a new name.

Enter a different description.

Change the size.

o

o O O

4. Continue to edit widgets by clicking the * More icon on the Actions bar:
o Change the order of widgets by selecting Reorder Widgets. Then drag and
drop the widgets in the list.

5. Add, remove, and edit Dashboards by clicking the * More icon and:
o Select Dashboard > Add Dashboard/Delete Dashboard. Create more than
one Dashboards to represent, for example:
m different phases of work, such as excavation, grading, and compaction
m different areas of the project site
m different date and time ranges
o Select Reorder Dashboards. Then drag-and-drop the Dashboards in the list.

6. Once your construction work has begun on site, review the work that has been
completed and the work that remains each day. When you process new .tag file
data, the applicable widgets are updated.

7. Open the Dashboard and click the ?Widget Filters icon at the top of any widget.

Work Completed =0:;
Progress from first to latest surface for selected p

"I Global Filters @

2,003.3m 863.1m

Cut Completed Fill Completed

8. Expand and edit the Dashboard Filters and Widget Filters as needed.

9. Click Apply when you are done.

Note: You can click on any widget to open the Map view for that filtered data.
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Share Dashboards

In addition to managing your own dashboards, you can also share a custom dashboard
with other colleagues that have access to the same project. The ability to share dashboards
(or receive ones shared with you) has these advantages:

e Only one person in your company needs to know how to set up a good dashboard.

e Your whole team can see the same Work Completed and Work Remaining data
calculated using the same filters. Your staff has a consistent understanding of a
project’s status

1. On the left-side toolbar, click the H Dashboard icon and configure the dashboard
as you want your colleagues to see it using the steps in Managing Dashboards.

2. Onthe Actions bar, click the : More icon in the upper right, and select Settings >
Select Dashboard > Share.

Trimble Westminster Project I e
(Productivity data last updated: 09/01/21 09:56 AM) & =
Section 2 +2 Section 3 Daily Work Complet... North Parking Lot D... Whi > -_T,_ﬁ *
-
P2y . « Dashboard
=< Section 3 Last Week N/
ted period. Progress from first to latest surface
= Reorder
12,487.0em / Edit
Cut Completed
« Share
=
13,9477 N
Fill Remaining _9 202 1(m’] B Delete
b ¢
Deficit
+ Add

Last Updated: 03/07,

|& Generate PDF

3. Scroll through the AVAILABLE list (people with access to the current project) and
click + next to each teammates name you want to share the dashboard with

(1 below).
Pn i
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Share My Shared
Dashboard

DASHEOARD DESCRIPTION

Please enter the information below for the
vould like to share the
dashboard with

FROJECT MEMBERS

Q Ssearct

AVAILABLE SHARE WITH (0)

Anthony
Antti

Arthur

Bharathiselvar

+
+

+

Becky +
+

Bill +
+

Brent

4. Tofind a colleague without scrolling through a long list, type their name in the
Search box (2 above), and click + in the AVAILABLE list. You can share to specific
individuals or everyone with project access.

5. Click Share (3 above). Each person you shared with is notified by email (which
includes your/the creator name, dashboard name, and description). Everyone you
share with gets immediate Read-only access (no edit, delete, filter functions are
available) to the shared dashboard.

The name of all shared dashboards appear above the view. Hover over the icon to
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see the email address of the creator/owner of the shared dashboard.

an First Shared Da... an Zone My Shared Dashboa...

Dashboard owned by:
@trimble.com

6. To see a list of people you have shared with (and potentially remove a person), click
the SHARE WITH tab (4 above).

Note: Because a company typically has only a few experts, only they will have edit
and share rights. This is why the average user only has read-only permissions.

Note: You can also see who has project access by clicking the Project icon >
More icon > View Project Members.

= ¢BTrimble WorksOS

3D Enabled (2) Non 3D Enabled (0) Archived (0)

A
3 Y g

o

Trimble Dimensions Trimble Westminster Project
3D Enabled 3D Enabled

Edit Project
Archive Project

View Project Members

—
Project Members
O wame
O Adam
O  Asn
0O  Abaha
O A
O serncer
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The Dashboard, Map view, and Progress Volumes screen each have their own settings and

other options that are accessible via the QSettings icon and the * More icon on the Actions
bar (at the upper right-hand side of the app).

Configure Map Settings and More

Configure the Dashboard

Project Settings (map colors and quality targets)

The Project Settings page contains all of the project targets and thresholds and all of the
color settings that can be customized for the selected project. This feature simplifies
customizing project targets and colors in Dashboard widgets, on the map, and in reports.

e Project Targets determines the ranges displayed in Dashboard widgets and the Map
page.

e Project Colors lets you configure default or saved custom color settings for every
Quality Metric data type for use in the Dashboard widgets and the Map page.

Configuring project targets

You can override target values from Machine Default values with custom target values. For
example, you may need to increase the acceptable grade tolerance on this design. By
overriding the lowest cut tolerance for Cut/Fill data, you can easily see the changes for
grade data reflected on the map and in the Quality Metrics slider statistics.

You can save your custom color selections in the color palette. This allows you to use your
saved colors for other quality metric data types without having to recreate a palette each
time. Saved colors are associated with user IDs and will be available for all projects
accessed by this user.

1. On the left-side toolbar, click the H Dashboard icon.

2. Click the¢Settings icon (on the Actions bar next to the * More icon) > Project

Settings.
TRANSFORMING THE WAY THE WORLD WORKS “g‘&':*TI'II'I'Ible.

WorksOS - User Guide 55



3. On the Actions bar, click the * More icon and select Settings > Project. Settings for
whichever category you have selected in Map > Metrics appear by default.

4. Select one of the filter types (Volume - Elevation).
5. Select Custom.

6. Click a color to access the palette. Use the color picker to choose a new color for the
quality metric. You can pick a different hue for the current color in the swatch, use
the slider bar to choose a new color, or enter a color's Hex value, RGB value, or HSL

F

value (click the ¥ arrows to access the entry formats).

7. Make changes to target values as needed.

Note: To reset targets to machine defaults, before saving, select Actions bar /
Reset to Defaults.

8. Click Save. The Map and Dashboard legends update with the new colors and target
values. The Map and Dashboard legends update with the new colors and target
values. Elevations have five colors to configure, which when saved are turned into a
graduated color palette on the map.

Note: To reset colors to machine defaults, click the * More icon and select Reset
to Defaults. This has to be done while you are in the Project Settings page.

Excluded Elevations

1. On the left-side toolbar, click the H Dashboard icon.

2. Click theQSettings icon > Excluded Elevations.

3. See the help topic called Apply Filters and Analyze Metrics.

More Menu

1. On the left-side toolbar, click the H Dashboard icon.

2. Click the * More icon.

3. See the help topic called Manage Dashboards.
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Configure the Map View

See above for Project Settings and Excluded Elevations.

Map Settings

You can control the types of files to display in the Map view. You can then use the Profile
tool to inspect a 2D cross-section of the work.

X

Map Settings

Alignments
Designs
Linework
Production Data
Cell Information

Devices

148 898 8

Drone Imagery

1. On the left-side toolbar, click the ﬂ Map icon.

2. Click theQSettings icon (on the Actions bar next to the : More icon) > Map Settings.
3. Toggle data types on/off to show/hide them in the Map view:

e Alignments

e Designs

e Linework

e Production Data
(controls surveyed surfaces; you cannot toggle Custom Areas (i.e., geofences)

e Cell Information (see below)
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e Devices
e Drone Imagery

4. Click X to close the pane.

Note: To see selected quality metrics and coordinates for an individual cell, select
Cell Information. To see where the cells are located on the profile line, select Cell
Markers.

More Menu
1. On the left-side toolbar, click the ﬂ Map icon.

2. Click the * More icon.

3. See the help topic called Import/Export Data and Run Reports.
Other Map Functions

Zoom In/Out

You can zoom in and inspect the data using tools such as the Profile and Controls tools. For
example, you can compare the design to the ground by drawing a profile line in the view. A
longitudinal profile of the design and production layer appears above the map. You can
select any point in the profile line to pinpoint the values.

Note: You can resize the map view vertically using mobile controls or your cursor while
the Map and Profile views are visible. Resizing the map view vertically exposes more (or
less) of the map to ensure the best use of limited screen space. The map view retains its
new size during the current session.

Note: Select the Zoom to Extents map control tool (top left of the map) to return to the
zoom level for the default Project Extents view.

Navigate the Map View

The Map page allows you to interact with data in a map overlay where you can inspect work
done by a combination of assets for the entire project area.

The Map page is filtered by the selected date range, widgets, and design files on the
Dashboard.
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Note: The project boundary dictates the time zone in which the machines report. This is
the time zone set when creating a new project in WorksOS Administrator. Keep this in
mind when you look at a project’s data reported in a time zone different from your
preferred time zone; this could impact your date range selections.

Use the map to visualize the as-built surface and validate the quality of the machine data in
the Quality Metrics slider.

The map is updated according to the selected Quality Metric in the Quality Metrics slider.

You can zoom in and inspect the data using tools such as the Profile and Controls tools. For
example, you can compare the design to the ground by drawing a profile line in the view. A
longitudinal profile of the design and production layer appears above the map. You can
select any point in the profile line to pinpoint the values.

Note: You can resize the map view vertically using mobile controls or your cursor while
the Map and Profile views are visible. Resizing the map view vertically exposes more (or
less) of the map to ensure the best use of limited screen space. The map view retains its
new size during the current session. Select the Zoom to Extents map control tool (top left
of the map) to return to the zoom level for the default Project Extents view.

The Detailed Data Viewer (DDV) tool decodes and outputs machine data for a single
selected cell on the map to a table that displays the complete history of all individual
machine passes (including raw Quality Metrics and all machine data types). This
information helps you analyze cell history and machine activity to pinpoint areas of interest
or to perform quality checks.

Refine, analyze, and export project data from the Map page.

Center

Moves your site to the center of the map view. (center of gravity?)
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Map Type

Opens a list at the top of the screen that allows you to choose from these background map
types:

Terrain

Map
Terrain

Satellite

Hybrid

Profile

You can zoom in and inspect the data using tools such as the Profile and Controls tools. For
example, you can compare the design surface to the existing ground surface by drawing a
profile line in the view. A longitudinal profile of the design and production layer appears
above the map. You can select any point in the profile line to pinpoint the values.

Create a Profile View
1. Click the Maps icon and the Metrics fly-out.

2. Select Elevation (or Cut/Fill). Elevation contours and graduated colors are displayed
for the highest (blue) to lowest (red) elevations based on filters and dates specified
(or cut, fill, and on grade colors are displayed) This color scheme is based on
surveyed data and machine productivity data.

3. Click the 4 Profile icon and pick two points on the map to create a line. The Profile
View shows profiles for any enabled surfaces along the line.

4. At the top of the Profile View, click the ::: Controls icon to check boxes for which
design, surveyed, and as-built surfaces (including specific passes) are shown in the
Profile View.

5. Control the vertical exaggeration using the X- Axis Ratio and Y-Axis Ratio sliders.
6. Zoom in to compare the surface elevations.

7. Pick a point on any profile line in the view to see the distance along and elevation at
that point.
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8. Continue to pick different point pairs to see other elevation profiles.

9. Click the Profile icon again to hide the Profile View. Profile can be done with any
quality metric. There is a Cell Marker Selection which turns on white dot cell markers
in the Profile view. Turn it on and zoom right in to see them appear.

Note: You can resize the map view vertically using mobile controls or your cursor while
the Map and Profile views are visible. Resizing the map view vertically exposes more (or
less) of the map to ensure the best use of limited screen space. The map view retains its
new size during the current session. Select the Zoom to Extents map control tool (top left
of the map) to return to the zoom level for the default Project Extents view.

Custom Area

Click points around a custom area which is then added to your filters. This enables you to
zoom into a specific part of your project site quickly and consistently.

Create a Custom Area

1. When drawing a custom area boundary, double-click the final vertex (white point) to
close the polygon. When you hover over the M custom Area icon (top right of the
map), a tool tip explains this function.

2. Save your custom area filter with a unique name. Custom area filters are available
for every user working with the project in this account. Only one custom area filter
can be used at a time. After you save the custom area, the map automatically zooms
to the custom area’s boundary. Click the Zoom to Extents icon (top left of the map)
to return to the zoom level for the default project extents view.

3. Click the Edit icon to draw a new custom area. You can click and drag vertices on the
boundary to reshape it. Click Save when you are done. Each custom area is saved
with the project for any users with access to quickly select.

Note: You will not see the custom area boundary take shape until you have drawn
three vertices (white points). When you close the polygon, gray interim vertices are
added for you.

Edit a Custom Area
You can edit a custom area boundary in two ways:
e C(lick and drag a white vertex to a different spot.

e Click and drag a vertex point to create a new vertex for a better fit over your data.
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DDV (Detailed Data View)

View Machine Pass History in the DDV

The DDV tool decodes and displays both machine production data and surveyed surface
data for a single selected cell on the map in a table that displays the complete history of all
individual machine passes (including raw quality metrics and all machine data types). This
information helps you analyze cell history and machine activity to pinpoint areas of interest
or to perform quality checks.

When activated, the DDV map tool displays the entire cell pass history for a cell, including
both machine passes and surveyed surfaces. By default, this cell pass history is in
chronological order from most recent to least recent; this logic also extends to ordering
surveyed surfaces by their survey date in accordance with machine pass dates/times. This
ordering can be reversed to show from least to most recent by clicking the Date/Time DDV
column header which will toggle the cell passes in the two ordering ways.

The DDV also recognizes any and all filters that are applied to project data and reflected in
the map and the quality metrics. A cell's pass data in the DDV reflects all filters applied and
returns the filtered subset of the data matching the filter criteria.

For example:

e If you filter to a single highest/lowest/first/last state and it is the surveyed surface
that meets that criteria, then only that single surveyed surface data is shown in
the DDV.

e If you filter to a single highest/lowest/first/last state and a machine pass that
meets the criteria, then only the single machine pass is shown; no surveyed
surface passes are shown in the DDV.

e Ifyou filter to a state that excludes a surveyed surface, then that surveyed surface
is not shown in the DDV.

1. Click the ﬂMap icon.

2. Clickthe ? Metrics fly-out and select either Volume or Pass Count.

3. Ontheright side, click the ** DDV tool icon to open the Detailed Data View table
above the map.
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4. In the Map view, click any cell that contains machine data. The DDV shows all
machine passes for the cell with the latest pass at the top. Information includes
date/times, design surfaces, elevations, target metrics, actual metrics, and machine
settings. Each individual machine pass is shown in a separate row.

5. You can use Date Range and other filters to refine the data displayed in the DDV. For
example, you can select a date range and machine design to filter the data to passes
by machines loaded with that design during the date range. See Filter Map Data.

6. DDV data for a single cell can also be downloaded from the table by clicking the &,
Download icon.

7. To close the DDV tool, click the *~ DDV icon again.

Configure DDV column settings

When the DDV tool is active, you can configure the columns to be displayed in the DDV.
This lets you determine the order of the columns and column visibility, and pin columns so
they remain in view as you scroll the DDV.

1. On the left-side toolbar, click the ﬂ Map icon.

2. Ontheright side, click the ** DDV tool icon to open the Detailed Data View table
above the map.

3. Make changes as needed, and click OK. The DDV updates to reflect your changes.

4. Select the Date/Time column in the DDV to change the view to the latest pass data
last or first.

Cell Information

The Cell Information tool allows you to see selected quality metrics data and coordinates
for an individual cell. Use Map Settings to turn Cell Information on/off Cell Information.

Cell Information

N1,210.655m-E 2,643.089 m
Lat 36.207374 - Lon -115.021274
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View Quality Metrics and Coordinates for a Cell

1. To enable the Cell Information tool, click the QSettings icon on the Actions bar (next

to the * More icon).

2. Click the * More icon on the Actions bar, and select Settings > and select Cell
Information and OK.

3. Select the Quality Metric in the Quality Metrics slider.

4. Use mobile controls on or hover the cursor over (desktop) the cell. A tool tip
containing the cell's Quality Metric data values appears at the bottom of the screen.

Elevation - Elevation value (for example, Elevation: 1265.8 ft)

Cut/Fill - Cut/Fill value (for example, Cut: 2.5 ft)

Cut/Fill Volumes - Cell coordinates only

Pass Count Details - Pass Count value (for example, Pass Count Details: 10)
Pass Count Summary - Pass Count value as a percentage of the target (e.g.,
Pass Count Summary: 10.5 %)

CMV Details - CMV value (for example, CMV Details: 20)

CMV % Change - CMV change value (for example, CMV % Change: 20.0 %)
CMV Summary - CMV value as a percentage of the target (e.g., CMV
Summary: 20.0 %)

MDP - MDP value as a percentage of the target (e.g., MDP Summary: 15.5 %)
Speed - Cell coordinates only

Temperature Details - Temperature value (e.g., Temperature: 100° C)
Temperature Summary - Temperature value

None (no Quality Metrics available) - Cell coordinates only

o O O O O

o O O O O

See details in Filters and Metrics.

Configure the Progress Volumes Screen

See above for Project Settings and Excluded Elevations.

More menu

1. On the left-side toolbar, click the @ Map icon.

2. Click the * More icon.
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3. See the help topic called Track Progress Volumes.

Other Options

Help

There are a variety of ways to learn, get help, and submit a support ticket, including:

Terms of Use
Privacy

Version info (About)
Legal notices

Community/Resource Center
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Apply Filters and Analyze Metrics

Review PPQ Metrics on the Dashboard and Map

Review Project Status on the Dashboard

After you have configured your Dashboard with widgets that give a quick look at the
movement of material, work completed, and work remaining, you can begin to monitor
progress, productivity, and quality (PPQ) values on both the Dashboard and Map view.
Once your field crews have begun, you will receive PPQ metrics from the project site as .tag
file data.

1. On the left navigation bar, click theﬂMap icon.

= BTrimble WorksOS

Dashboard

Work Completed
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2. Explore the map filters, controls, and metrics:

= : Trimble Westminster Project i
= BTrimble WorksOS phhelpbaion LI

(Productivity data

(el Proicct Extents 08107/17 - 09/01/21 g

o

Cell Information

N 367,266.614 m - E 948,220,993 m
Lat 39.894347 - Lon -105.107683

o ez c N

@ Trimble MAPS = Trimble Inc. | 2 Opsnhisp

Metrics > Elevation, Volume, Pass Count, CMV, MDP, Speed, and Temperature
Selected Filters
Settings > Project Settings, Map Settings, and Excluded Elevations
More > Imports, Exports, and Reports
Zoom In/Out
Center (project in the view based on center of gravity within the boundary)
Map Type
Profile
9. Custom Area
10. DDV (Detailed Data View)
11. Cell information
See sections below for details on each of these.

Nk~ WN =

Selected Filters

There are two types of Dashboard filters:
e Globalfilters are applied to the Dashboard and control filters in all widgets.
e Widget filters are applied to individual widgets. These filters can be added to
or override global filters.

[ oy 1
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These filters are ‘sticky’, which means Dashboards retain their filter settings when
you log out and back in, which saves you from having to reselect filters each time.

Configure Global Filters
—
1. Click the Global *~ Filters icon on the Actions bar at the upper right.
2. Expand each filter and select one or more options as needed. Some filters
allow multiple selections.
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Filters X As you choose options, they appear at the

top of the pane.

04/12/22 - 04112122 Filters X

Finish Design - Mapping X 2 Machine Selected B
08/18/20 - 08/18/20
Clear All
WRNO0487 X | 140M262116 X
Date Range - Lowest Pass X

Current Week

e

Clear All

Previous Week

Current Month

Previous Month

Last 31 Days Project Extents
Custom
Favorite Filters -
Machine Name -
Design Boundary -
Machine Design §) i

Q

LA
im

L
=
2,
N

Trimble
-
Tulemmluln DR Bauledm-"2 A8 40

Cancel Apply
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3. When you have a lot of options, you can also use Search to find the ones you
need, as well as click the Sort icon to list them alphabetically.

Custom Area -

Q, searcr AZ
U

Bldg2 Court

4. Click Apply when you are done. The Map view, Dashboard, and its widgets
are updated based on the global filters.

—F
Numbers next to the == Global Filters icon and filters indicate how many
filters are applied. Any widget you add to the Dashboard inherits the global
filters from now on.

=0 ;

Filters X

Date Range - =
Favorite Filters -

Machine Nam & =

Design Boundary -

Machine Design -

Lift Number -

Elevation @ ) =
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5. To view which filters are applied to the Dashboard and widgets, hover over
(desktop) or press and hold (mobile) any filter icon.

Work Completed ?%5

ogress from first to latest surface

K

12,160.9 2,704.0em
Cut Completed Fill Completed G |I:I tlﬂ I Fi |tE' rs
14,864.9 10/30/12 - 1107712

Total Volume

Widget Filters

Y sT=R &1
Vil e (i

Configure Widget Filters

1. Switch to the Dashboard and click the = Widget Filters icon at the top of a widget
you want to configure.

Note: For the Work Remaining widget, you must have a Design Boundary filter
applied.

2. Select the filters from the Widget Filters category lists. Selected filters apply only to
the widget and will not impact the rest of the Dashboard. Widget filters are added to
the global filters or override existing filters.

3. Click OK. The widget updates based on the filters.

4. To view which filters are applied to the Dashboard and widgets, hover over
(desktop) or press and hold (mobile) any filter icon. A pale orange global filter
indicates it is overridden by a widget filter.

Note: When you navigate to the Map page from the Dashboard (not from a
widget) you navigate to Elevations with the Project Extents date range filter set.

Filter Dashboard Data

The primary Dashboard filters are:
e daterange
and
e design surface or design boundary

" W
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When you click a widget, the filters applied to that widget are applied to the Map view, e.g.,
a good way to run a calculation from the Dashboard to the Map is by running volume

—F
calculations. From the Map view, you can also apply the global filters by clicking the =
Filters icon on the Actions toolbar. Hover over the filter number icon to see the active
filters.

Filter Map Data

You can filter mapped data by date range and many other factors to help you visualize the
project state you want to see. The date range filter is always applied to the displayed data.
Applying an additional filter further refines the displayed data.

—F
1. Click the == Global Filters icon.
2. Select the filters from the filter category drop-down lists.
—F
3. Click OK to apply the filters. The number next to the == Global Filters icon indicates
how many filters are applied.

For example, to understand what a particular machine did on a specific day in a specific
project area:

1. Filter to the day using a date filter such as Today, Yesterday, or Custom day. Date
Range is a required filter.

2. Apply a Machine filter to select the specific machine whose work that day you want
to view.

3. To display work done in only one area, use the Custom Area filter by clicking the

1 Draw icon on the map and drawing the area of interest. This will adjust the
displayed data for just that custom area. All of the metrics will adjust based on the
applied filters.

Filters You can Apply

You can apply as many of these filters to a data set as you need. Favorite filters can be
reused in reports or elevation surveys. You can also find them within volume and Work
Remaining calculations.

Date Range

Refine your project data (including surveyed surfaces) to a set period in time, including
Today, Yesterday, Current Week, Previous Week, Custom, or the default value: Project

: \ 2 Trd
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Extents. A Date Range filter must always be applied to your project. Using the Custom date
range filter, you can also specify the hours and minutes.

Note: Project Extents does not use the project start and end dates. Instead, it sets the
date range from the first day project data was received to the date of the most recently
received project data, which lets you see all project data at once. The Custom date range
lets you set a range of dates and times within the Project Extents.

Note: The project boundary dictates the time zone in which the machines report. This is
the time zone set when creating a new project in WorksOS Administrator. Keep this in
mind when you look at a project’s data reported in a time zone different from your
preferred time zone; this could impact your date range selections.

Favorite Filters
This option shows and lets you quickly reuse your saved filters.

Configure Favorite Filters

To save time, you can save a combination of filters as a Favorite filter. This allows you to
use your filter combination without having to rebuild it each time.

Note: Although the Date Range is set in a separate window, it will be included in the
Favorite filter.

—F
1. On the Map page, click the =~ Global Filters icon .
2. Select the filters you want.

3. When you have configured a commonly used filter, click the " Favorite icon to save
it to your favorites.

Filters X

1 Machine Selected

06/12/17 - 06/21/18 SP0451 X
First Pass X Vibe On X

g Clear All
[y
4. Save it with a unique name, and click OK.

Note: The Favorite filter is available only to the Favorite filter creator. Favorite
filters are not shared with other users working with the project in this account.

- \ 2 Trd
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Filters X

1 Machine Selected

My Filter __//
06/12/17 - 06/21/18 ‘ SP0O451 X

12D

Clear All
Date Range =
Favorite Filters| @ a
\/Myﬂl:erv

Edit a Favorite Filter

1. Select the filter in the Favorite Filters list.

2. Select the filter criteria you want to add and delete the criteria you do not want.
3. To overwrite the filter, click Apply.
4

. To save the filter as a favorite with a different name, click the 7 Favorite icon, enter
the new name, and click Save.

Delete a Favorite filter

1. Select the filter in the Favorite Filters list.

2. click the *¥ Favorite icon.

3. Click Delete.

Machine Name

Refine data to machine production data and surveyed surface data from a single or
multiple assets. This filter lists every asset that has submitted production data to the
project (using the name of the control box installed on each machine operating within the
project boundaries).

b -
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Design Boundary

Refine data to any that exists within a single design boundary.

Note: These design boundaries must be imported or created as reference surface
files and selected in the Project Files window.

Machine Design

Refine data to the on-machine design loaded onto a single asset that has submitted
production data to the project. This filter shows data only while the design is loaded onto
an asset. Any data regardless of location is shown for the selected machine design.
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Note: The WorksOS 'Machine Design' filter reads surfaces from Trimble Earthworks.to
accommodate more granular Earthworks machine filtering. Trimble Earthworks
machines that have a machine design and also a surface selected in the field reflect
this in the Machine Design filters in WorksOS. The Machine Design filter options will be
appended with the subselected surface name. Different surfaces loaded to the same
existing machine design will appear as unique filter options, e.g.,
"DESIGNA_SURFACE1*", "DESIGNA_SURFACE2". This logic enables you to filter an
individual Trimble Earthworks machine's productivity to a higher degree of accuracy.

DESIGN: VCL Kettlewell Drive (R11) 190321

/:SU‘RF.’;C’E: 180302 KD Site + Extension (Preliminary)
-
‘Design’ and ‘Surface’ selected =~

on an Earthworks Machine .
Filters X

25/11/20 - 07/12/21
‘Design’ and ‘Surface’ combined VCL Kettlewell Drive (All)
in a ‘Machine Design’ Filter — ) .
. . 190321_180302 KD Site + Extension X
option (previously only used to
be ‘Design’ field). (Preliminary)
Lift Number

Refine data to a single machine-defined lift by number, which can be a range of machine
passes and elevations. This filter is available for any lifts that have been entered by an
operator on a control box.

- - - -— -— - —

- - e -

Elevation

Refine data to the series of cell elevations that make up the combined Highest, Lowest,
First, or Last Pass for a specified area. This filter shows all cells at their highest, lowest,
earliest, or latest set of elevations. Lowest pass is a good choice for excavator data to get

b -
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an idea of the starting surface. If you specify a different area, the color key is recalibrated
for the area.

Alignment

Refine data to an imported alignment of linework file using a defined Start and End Station
Range and Left and/or Right Offset to filter data for. When these selections are populated,
the Alignment filter includes data only within the selected spatial extent and excludes all
other data. These settings help eliminate excess data when doing a roadway project.

Vibe State

Refine data to submitted data from CMV-enabled compactors that performed vibratory
compaction (Vibe State On) or non-vibratory compaction (Vibe State Off).

& Trimble
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Note: When this filter is active, all other machine data is excluded.

Machine Direction

Refine data to machines that were moving forward or in reverse.

Geofences/Custom Area

Refine data to within geofences or to areas where you used the Draw tool to draw a
polygon on the map to inspect data only within the area. Production data outside the
boundary is excluded.

@ Trimble
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For more information, see Create a Custom Area below.

Pass Count

Refine data to a Min - Max pass count range. This filter is designed for compaction users
who want to analyze Quality Metrics data filtered by a pass count range without having to
export and analyze the data outside of WorksOS. Filter by Pass Count requires a lower and
upper pass count range to be specified. You will see the data extents, which is the number
of available passes to filter from within the range. You can set the filter to return quality
metrics data such as temperature, CMV, speed, etc., from within that range. The Pass Count
filter is applied after all other filters have been applied. This is done because the Pass
Count filter interacts with and depends on other filters that have been applied to data.

Filter by Pass Count looks at individual passes within each cell. In this example, your
machine data comes from 4 cells (Cells A - D). You are interested in a pass count range of 3
to 4. As shown below, data from passes 1, 2, and 5 would be excluded while data from
passes 3 and 4 would be included. Data from Cell C would be excluded while relevant data
from Cells A, B, and D would be included:

Excluded

Excluded
Excluded

Cell & CellB Cell C CellD

Temperature

Refine data to a Min - Max asphalt temperature range. This filter is designed for asphalt
compaction users who want to analyze Quality Metrics data filtered by a temperature
range in their choice of units. Filter by Temperature Range requires a lower and upper
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temperature range to be specified. You can set the filter to return quality metrics data such
as pass counts, CMV, speed, etc., from within that range. The Temperature Range filter is
applied after all other filters have been applied. This is done because the Temperature
Range filter interacts with and depends on other filters that have been applied to data.

Automatics

Filter by Automatics filters machines when they have Automatics engaged in their GCS or
Earthworks Machine Control systems and when they do not. It can provide a starting point
for efficiency measurements (for example, time using Automatics mode vs. time not using
Automatics mode). Site managers and project foremen use this filter to check when
operators engage machine control and/or to remove unnecessary production data.

When a machine is using Automatics mode, its blade, bucket, or drum automatically tracks
work done to achieve the machine’s loaded design grade. Best practices for Machine
Control often include using Automatics mode as often as possible.

The Automatics filter has Automatics On and Automatics Off selections that refine and
return Quality Metrics data. Automatics On includes states such as Auto, Inactive Auto, etc.,
from Machine Control systems. When the filter is active, it excludes data from machines
that do not have Automatics configured (Undefined).

Excluded Elevations

Use the Excluded Elevations filter to specify the valid elevation band for your project.
Machine data with elevations above or below this range will be excluded from calculations.
This can help improve the accuracy of your material volumes. Filtered data is not deleted or
otherwise purged. This setting is disabled by default.

1. On the left navigation bar, click the ﬂ Map icon and in the Elevations Quality
Metric you will see your current Project Elevations range.

: \ 2 Trd
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Quality Metrics X -~ . A .b‘_‘. (8 . 4 - ‘ f
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2. Click the ’:' Settings menu icon and select Exclude Elevations.

3. An Excluded Elevations slider dialog will appear on the right-hand side of the screen.

— 0
T < §
Excluded Elevations x
("3 Turn On Elevation
E
E m
¥ 1M T
(=28 m

Apply Elevations

4. Enter the Minimum and Maximum Elevation range values (every elevation above
and below this range will be excluded).

5. Click the ‘Apply Elevations’ button.

6. To apply the Elevations Range to the data click the ‘Turn On Elevation’ toggle. The
slider will close and the data will automatically update on the Dashboard, Activity
Dashboard, Map and Progress Volumes Pages.

7. Review your model data without the elevations you filtered out.

h L
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Quality Metrics X

Elevation
-

LEGEND Excluded Elevations only () y
-
2700% Maximum Elevation £
G

1,870,00 ft
4

Minimum Elevation
1,950.00 ft

Note: You can turn off Excluded Elevations by accessing the menu again and
toggling it off.

Note: To see and analyze just the data that has been filtered out, switch back to
the Elevations Quality Metric and toggle Excluded Elevations Only on.

Project Extents 25/10/12-07/11/12

" . - - - - - *’ -
Quality Metrics X Fﬁ"' = N .!\‘_“7 ' 3 . et - ‘ p
0% e " |
1
f
“ ‘ -
: ..a..— ~ar, ™
I \ EXCLUDED ELEVATIONS CAN STILL BE VIEWED, ANALYZED AND EVEN REINCLUDED
iy - ! - 42 f'-lq'r ]
8. On the right side menu, click the *** DDV tool icon to open the Detailed Data View.
9. Click a location on the map to pick a cell, and review raw data properties like what:
machine collected the data
o design was loaded
o coordinate system was used
o the date and collection time was
h::‘h ]
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o the GPS accuracy was
to see if changes need to be made in the field.

10. Click the ** DDV tool icon again to close the Detailed Data View.

Tip: If you see data that should have been included in calculations, go back to the
Elevation Range filter and adjust the top and/or bottom elevations to re-add it.

11. To export the raw data (while still viewing excluded elevations), select More >
Exports > Machine Passes.

12.To generate a summary report with a screen capture (while still viewing excluded
elevations), select More > Reports > Summary. The exported data and reports can

help you analyze and prevent the collection of data with invalid elevations in the
future.

Note: When you are in excluded elevations, the export and report options will
only pass the excluded elevation data. When you are not viewing excluded
elevations, the export and report options will pass the elevation data not
including the excluded elevations. Be careful to be in the right mode when you...

Filtering your data by elevation range affects everywhere you see volumes, such as:

e Dashboard volumes
e Progress volumes

@ a0 04120
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Tip: Use your Profile Viewer to check for elevation spikes in your data. On the

right side of the Map View, click the 4 Profile icon and pick two points on the
map to create a line. If the profile along the line looks anything like this, you may
have bad data that needs to be filtered.

Ph 1
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Metrics

Elevation

B Trimble Warks0Ss frmble Wastmanater Frogect HOOa

Prepec lxbarsta 05 21T (21118

Quality Metrics

D

Elevation filter

Uses: Excavations

Volume

Terms in heavy construction and earthmoving used to indicate whether soil is to be
removed or added, respectively. Get a Work Remaining (cut/fill) map relative to the
available elevation data and any imported designs.

Note: There is no separate Work Remaining metric in WorksOS. Instead, see Work
Remaining for volumes).
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Cut/fill map

A map with shading and/or a grid of measurements at an interval showing the
elevation differences between two surfaces, such as an original ground surface and
a design surface. Cut/fill maps are color-coded to indicate where earth needs to be
cut (on page ) or filled (on page ). See Compare Surfaces and Calculate Volumes.

Uses: Excavation and Grading type projects

Pass count

A measurement of the number of times that a machine (e.g., roller compactor) has traveled
over an area on a surface.

Progect Kxtents D60 217

Quality Metrics

b

Uses: Compaction

h:“h 1
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Compacted meter value (CMV)

A measurement of the relative stiffness of compacted material as measured by a sensor on
a compactor.

(Proect fxneaty 1G] - 1T T

Quality Metrics 3

oy

SUMMARY . (ARG CATARS

s Dt it

Uses: Compaction

Machine drive power (MDP)

Machine drive power values recorded by compaction machine systems.

IProject Dxtemty 000012 - 1100007

Guality Metrics 4

'
§
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Uses: Compaction

Speed

IProjeci Kabmia 100813 - 1S

Quality Metrics

Uses: Compaction
Temperature
Quality Metries

Tamga sty

Aummpiy eiTani

B Dusts dradabole

Uses: Compaction
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Work Completed

Preject Dxtens 06712717 - 027008

Qualiey Metrics =
Comglsted Srrmaining
Caloulation -
From

Ts

Volume - Work Remaining

Project Rxtersta 061 317 - (W 31018 E‘]
Cruality Metrics
Campiees

Cabrulanion

Mo Dlata Availabie

Mo Dt Avslabia
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Addendum

Understand Cut/Fill Colors

In WorksOS, the Work Completed calculation compares the volume and elevation change
between two surfaces and assigns colors based on the Project Settings. ‘Grade’ = Original
untouched surface.

The color changes as the elevation changes from ‘Grade’.
Using the defaults, if you cut an area down <-0.16 feet it will remain green.
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B Trimble WorksOS

Volume Pass Count CMy

Cut/Fill

@.":I'
O.- T

Elevation change From
surface To surface is < 0,16

} Green = Grade (Cut less than
—| .0.16")

= B f
SRADE

Elevation change From
surface To surface is > .1.16"

Red=Cut (Cut more than
0.16')

A6 fe 28 fz 50 f S2ft Layer View Dptinns

From

M
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Cut less than 0.16" = Green

S

Cut between 0.16" —0.33" = Pink

Cut between 0.33" — 0.66" = Light Red

Distance: 54.160 ft
Elevation: 905412 ft

Cut: 0.384 f;

s ]
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Cut » 0.66" = Dark Red

How to view in WorksOs

When on the Profile tool, click the settings button
This will display; To Surface, From Surface, Designs and Surfaces
Increasze the Y-axis to better view small areas.

=0
- &
Profile Controls X
Prafile Tool Options Lo
O Cell Marker Selection Click on the From Surface line over one of the
Keforks Ratic white lines to disolav cell information
& L §
Yuliuid Ratio
-
Layer Wiew Options =
M rom
bd  To )
Designils) n Fi
e
1-P-FG. 1 i
Surveyed Surfacels) = ‘
R -
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Track Progress Volumes

Tracking Progress Volumes

A preconfigured set of daily calculations and three views enable you to easily see the
volumes of cut and fill materials moved on your job site on a day-over-day basis. These
progress volume features allow you to analyze earthmoving progress during any time
period you specify and in any project area you choose.

The data for progress volume views comes from both machine TAG (.tag) files and surface
surveys (.ttm). When importing a .ttm file for progress volume calculations, always specify
that it is surveyed surface and select the data and time to which it applies; doing this
timestamps and dates the survey data to align it with any machine data that is
automatically imported in the same time frame.

If you have applied material density (shrinkage and/or bulkage) factors for materials, the
reported volumes reflect this.

Note: Progress volumes functionality is not specifically connected to the Dashboard and
Map screens. l.e., the Dashboard does not account for progress volumes; this means the
dashboard calculations (other than Today or Yesterday) will not match progress volumes
as the filter setup and calculations are different on the dashboard.

To access the Dashboard, click the Dashboard icon on your left-hand navigation bar. The
dashboard automatically includes these five dynamic Work Completed date range
widgets that support common workflows for volume calculations:

Work Completed - Today

e Work Completed - Yesterday
e Work Completed - Current Week
e Work Completed - Previous Week
e Work Completed - Project Extents
s -
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B Trimble WorksOS F-)

Dashboard =0;

Work Completed - Today =0; Work Completed - Yesterday =0; Work Completed - Current Week =0; Work Completed - Previous Week =0;
Progress from end of yesterday to today Progress from before yesterday to end of yesterday Progress from end of previous week to end of cu Progress from before previous week to end of pre.

10,086.5( pr

Surplus ToralVolume.

Last Updated: 03/09/21 04:06 PM Last Updated: 03/09/21 04:06 PM Last Updated: 03/09/21 04:06 PM Last Updated: 03/09/21 04:06 PM

Work Completed - Project Extents = @
progress from strt o Project to end of Project

-6,674.9m

Defiax

Last Updated: 03/09/21 04:06 PM

Default project dashboard

These represent total cut and fill quantities for the specified time periods. With just a
surveyed surface, e.g., Original Ground, as soon as your machines start working, the daily
or weekly difference from time frame to time frame can be calculated.

You can also add a Work Remaining widget, which is always relative to a specific design that
you imported. This design gives you a surface to compare to.

The widgets are built from existing filters.

Filters X

Date Range a

Today Yesterday
Current Week
Previous Week
Current Month
Previous Month

Last 31 Days

Views for Progress Volumes

There are three types of views of for progress volume data:

Ph 1
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e Graph view - A bar chart of cut and fill volumes broken down by day or week helps
you see the trend of material volume movement in your project area, Each bar is
separated into cut and fill colors representing the volumes moved. Hover over or
click any bar chart for details on the exact cut and fill volumes for that day or week,
as well as the cumulative volume for the project up to that time. The chart also
includes a line graph of the cumulative volume over time for the date range you
have selected. Scroll in/out in the view to see fewer or more days in the view.

e Grid view - An even more detailed table of values sorted by date allows you to see
the exact cut, fill, total, and cumulative values for every working day. You can also
export this grid to an CSV file for greater data analysis and visualization in
Microsoft® Excel.

e Map view - A birdseye/plan view of your project geographically that shows all the
areas in which material has been cut or filled over the entire project time period. To
see a smaller set of progress volume data, you can reduce the date range or spatial
boundaries shown in the map view.

Accessing the Progress Volume Views

1. Click the Progress Volumes icon on your left-hand navigation bar in WorksOS to
access.

Dashboard

Work Completed - Today =0; Work Completed - Yesterday =90;

rom end of yesterday to 1 of yesterday

2,249.0¢ 1,404.5w 10,272.0em

Cut Completed Fill Completed Cut Completed Fill Completed

3,653.6im 10,086.5(m 10,457 4w

Surplus Total Volume Surplus Total Volume:

| Progress Volumes
™ oot Ubdatird: 03/09/21 04:06 PM Last Updated: 03/09/21 04:06 PM

2. Click one of the 3 icons (Graph View, Grid View, Map View) at the top of the pane.

® GraphVie\: ble ® wle @ Trl

Total V

Q = —
Q olo ) ¢ h = %ﬂ
" W
TRANSFORMING THE WAY THE WORLD WORKS & Trimble

WorksOS - User Guide 96



Graph view

The Graph View shows every day, start to finish. You can see here linear progression (bar
charts) over the weeks. This can help you track the consistency of material volume
movement as you normally would in the field (How much material was moved?) In addition,
the black line with dots shows the cumulative material volume. Click any bar to see the
daily cut, fill, and cumulative volumes.

anmbIe WorksOS Trimble Westminster Project 5 e

Custom 06/12117-06/30/17 =0 ;

Trimble Westminster Project Progress Volumes

otal Volume: 65,432.5 m* | Total Fill: 41,276.2 m? | Total Cut: 24,

dE 0 DALY ~

— CumulativeVolume @ Totalcut @ Total Fill

Daily Volume (m2) Cumulative Volume (m?)

20,000 70,000

50,000

40,000

20,000

10,000

0612117 061317 o6/14/17 061517 06617 0617117 o687 o6/t9/17 0620117 0621117 0622117 0623/17 062417 0625117 06/26/17 06127117 0628/17 06120117 0630117

Progress volumes daily graph

Graph View functions

The chart is configurable with a limited number of filters:
e Daterange
e Spatial such as boundary, alignment, or custom area
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The chart is dual axis and includes three scales:
1. Daily values are shown on the left.
2. Cumulative values are shown on the right.
3. Dates are shown on the bottom.

— Cumulative Volume @ TotalCut @ Total Fill

Daily Volume (m?) Cumulative Volume (m?3)
25K - N - - " N N ~ N 100K
T S 90K
20K — — 80K
TOK
15K 60K
50K
10K 40K
30K
5K 20K
10K
S
0 W —_— p— — — 0
B0 o o e ® e o o o

You can click a legend label to toggle Cut, Fill, and Cumulative bars on/off in the view. If, for
example, you are only being paid for cut volumes, simply remove fill from the chart and track
the daily cut quantities. If you are doing a landfill job, you can toggle cut off so you see only
fill volumes.

— Cumulative Volume @ TFetatest @ Total Fill

b -
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The total volume is always listed at the top of the chart under the name.

Project Extents 06/01/17 - 06/22/18

"Project Progress Volumes

Total Volume: 95,820.9 m?3 | Total Fill: 57,980.7 m? | Total Cut: 37,840.1 m?

You can also filter by Daily or Weekly. Weekly combines the daily charts into weeks and
sums them.

DAILY =

— Cumulative Volume @ Total Cut Ll

Cumulativi  WEEKLY

100000

P —————————

”s .
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= B Trimble WorksOS Trimble Westminster Project % e

Custom 06/12/17 - 06/30/17

Trimble Westminster Project Progress Volumes

481.2 0 | Total Fill: 42,185.9 m* | Total Cut: 24,295

WEEKLY ~

— Ccumustevolume @ Toicut @ TotlFil

Cumulative Volume (m3)

70,000

35,000
60,000

000
50,000

25,000
40,000

20,000
30,000

5,000
20,000

10,000

0611917 - 06125117

Progress volumes weekly graph

You can also filter the view in the standard way, but filters for progress volumes are
independent from other Dashboard filters.

= B Trimble WorksOS Trimble Westminster Project 5 e

Custom 06/12/17 - 06/30/17 =0 ;
Trimble Westminster Project Progress Volumes Filters x
Total Volume: 65,432.5 m? | Total Fill: 41,276.2 m? | Total Cut: 24,156.3 m?
= oararts-oazon7
D=0 ==
— cumulaty W ClearAll
Daily Volume (m3) Date Range -~
Favorite Filters -
Design Boundary a
Q se AZ

14000
Trimble Bldg 2 - Finish Grade.ttm
12000
Trimble Bldg 2 - Finish Grade -1.5f¢

10000 .
Alignment -

8000 Custom Area -
6000

4000

2000

0612117 0613417 06114117 061517 06/16/17 061717 0618117 06119117 0620117 0621117 0622117 06123117 0624117 06125117 06/26/17 0612717 06128 Cancel T

Progress volume daily graph with filter panel
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= bTﬂmble WorksOS 11461-STX 151 Plant )

Project Extents 01/20/21 - 03/09/21 _—:0 &
Progress Volumes

Total Volume: 116,853.7 m® | Total Fill: 61,968.2 m* | Total Cut: 54,885.5 m?

diE 0 WEEKLY +

— cumstievolime @ Tomicut @ Tt Fil

Cumulative Volume (m?)

120,000

100,000

80,000

25,000

20,000 60,000

15,000
40,000

20,000

0112021 - 01724121 01125021 - 01731721 02001121 - 0200721 02108721 - 02114121 0211821 - 02721121 0212221 - 0212821 0310121 - 0307121 03108721 - 03109721

Progress volumes weekly graph
Scroll in/out to see a shorter or longer time period in the chart.

—
To specify an alternate time span, click the Global 2F Filters icon on the Actions bar at the

upper right. Se Date Range Filters > Custom

Filters X
Date Range a

Today Yesterday
Current Week
Previous Week

Project Extents ~ Custom

Custom Date Range

From

06/01/17 00:00 m

Note: The maximum project extents (date range) is 1000 days, but the default extents
for the Graph View is the last 31 days, not the full project extents.

Tip: Save your custom data range as a Favorite to quickly apply it at any time.
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To configure the cut and fill colors, as well as material density factors (shrinkage and
bulkage), click the More icon (ellipsis) and select Project Settings > Volume. The factors you
set are reflected in the material volumes.

Cut/Fill Bulkage/Shrinkage

@ Defau - O Default BULKAGE:
cuT .

o Custor @ Cust 04 %

. ' SHRINKAGE:
i %
GRADE
- B
Grid View

Select the Grid View for a table of values with the exact cut, fill, total, and cumulative values
for every working day. You can also export this grid to an CSV file for greater data analysis
and visualization in Microsoft® Excel.

B Trimble WorksOS

Custom 06/12/17 - 06/30/17

Total Volume: 65.432.5 m* | Total Fill: 41.276.2 m? | Total Cut: 24,156.3 r

M=

Date ¥ Fill Volume (m#) Day of the Week Cut Volume (m3)
619.4 Friday 7

6/2 5.2 ond. &
6/2! Sunday

6/24/ Saturd,

6/23 67.6 iday 2.
0672 Thursda 4

TRANSFORMING THE WAY THE WORLD WORKS

Trimble Westminster Project Progress Volumes

Trimble Westminster Project H 6

Total Velume (m?) Cumulative Volume (m#) Cumulative Cut (m?) Cumulative Fill (m?)

24,156.3 41.276.2
24,1446

64,801.5 24,1446 40.656.9
7 4,801 24,144

@ Trimble
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Grid View Functions
You can drag-and-drop columns and sort by column headers.

To toggle columns on/off in the Table Settings pane, click the Settings icon.

% ﬁ DAILY v

Table Settings X

= Date 1 &
= DayoftheWeek II @
= CutVolume I o
= Fill volume I &
= Total Volume I e
= Cumulative Volume I @
= Cumulative Cut 1 &
= Cumulative Fill I &

= ¢BTrimble WorksOS

Custom 06/12/17 - 06/30/17

Trimble Westminster Project

Trimble Westminster Project Progress Volumes

Total Volume: 65,4325 m# | Total Fill: 41,276.2 m? | Total Cut: 24,156.3 m

i E 0
pate ¥ Fill Volume (m?) Day of the Week Cut Volume (m?) Total Volume (m?) Cumulative Volume (m?) Cumulative Cut (m?) Cumulative Fill (m?)
619.4 Friday 1.7 6311 654325 01,2762
Thursday o 0 64,801.5 241446

5/28/17 64,8015 2414456
4,80 4,
ond: 32464 841
sunday
d: 37,440,
7. 2 1 37,44C
hursday 86
4 3.2477 4,
esd 4115, 18, 743, 243
ond: 4 8.64: 4 2 1
8) sunday 3 8557 142

Progress volumes grid view with Table settings
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Table Settings X
= Date I o
= Fill Volume I @
= Day of the Week I o
= CutVolume I o
= Total Volume I o
= Cumulative Volume I @
= Cumulative Cut I o
= Cumulative Fill I o
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To export the grid values to CSV for more sophisticated data analysis, manipulation, and
visualization in Microsoft Excel, click the download icon.

A B C D E F G H

1 ITrimbIe West_}ninster Project Progress Volumes

2 Total Volume: 85,820.9 m? | Total Fill: 57,980.7 m? | Total Cut: 37,840.1 m?

3

4 Date Day of the Week Cut Volume (m?) Fill Volume (m?) Total Volume (m?) Cumulative Volume (m?) Cumulative Cut (m?) Cumulative Fill (m?)
5 6/22/2018 Friday 1.6 5.1 6.7 95,820.90 37,840.10 57,980.70
6 6/21/2018 Thursday 43.5 80.5 124 95,814.20 37,838.50 57,975.70
7 6/20/2018 Wednesday 0 0 0 95,690.20 37,795.00 57,895.20
8 6/19/2018 Tuesday 0 0 0 95,690.20 37,795.00 57,895.20
9 6/18/2018 Monday 69.8 52.9 122.7 95,690.20 37,795.00 57,895.20
10 6/17/2018 Sunday 0 0 0 95,567.50 37,725.20 57,842.30
11 6/16/2018 Saturday 0 0 0 95,567.50 37,725.20 57,842.30
12 6/15/2018 Friday 6.2 92.3 98.5 95,567.50 37,725.20 57,842.30
13 6/14/2018 Thursday 6.7 1.9 8.6 95,469.00 37,719.00 57,750.00
14 6/13/2018 Wednesday 0 0 0 95,460.40 37,712.30 57,748.00
15 6/12/2018 Tuesday 0 0 0 95,460.40 37,712.30 57,748.00
16 6/11/2018 Monday 2435 82 325.6 95,460.40 37,712.30 57,748.00
17 6/10/2018 Sunday 0 0 0 95,134.80 37,468.80 57,666.00
18 6/9/2018 Saturday 0 0 0 95,134.80 37,468.80 57,666.00
19 6/8/2018 Friday 322.5 56 378.5 95,134.80 37,468.80 57,666.00
20 6/7/2018 Thursday 310.6 229.7 540.4 94,756.30 37,146.30 57,610.00

Map View

This view lets you see the areas your machines cut and filled geographically on the project

site.
Ph -
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= g Trimble Westminster Project Y
= dBTrimble WorksOS Pldveadie e il g L

Custom 06/01/17 -09/01/17 200

Trimble Westminster Project Progress Volumes

Total Volume: 73,113.0 m® | Total Fill: 37.138.5m* | Total Cut: 35,974.5 m®

hE e &
Volume Information X 3 Map Settings X
Total Volume IR Alignments -0
73,1130 m*
D -0
Total Fill el
T8 Linework -0
Total Cut
3 Production Data -0
Devices -0
Drone Imagery -0

Total

Working Days
21

Weekly Average
Cut: 5,995.7 m?

Total 5m?*

Working Weeks

Progress volume map view

Map View Functions

To toggle certain types of data on/off in the Map Settings pane, click the Settings icon.

X

Map Settings

Alignments
Designs
Linework
Production Data
Cell Information

Devices

148 88 88

Drone Imagery

h:“h 1
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Click the Volume Information arrow on the left side to see totals, including daily and weekly
averages.

Volume Information X

Total Volume

73,113.0 m?®

Total Fill

37,138.5 m?

Total Cut
35,974.5 m®
Daily Average
Cut: 1.713.1 3

Working Days

Weekly Average

Working Weeks

Note: Total Volume, Daily Average, and Weekly Average include both cut or fill, as
applicable.

Note: Any non-working (0 volume) days/weeks are excluded from the Daily/Weekly
Average.

Tip: Filter by new date ranges to see working areas and averages for specific time
periods. This can help you, for instance, identify seasonal productivity patterns.

Note: If you cut and fill the same volume during the same day, the change is net 0.0. If
you cut one day and fill the next day, there is a day-over-day change. Before WorksOS,
this was done based on load counts. In this case, progress is measured by looking at the
day-over-day change. There is usually an objective goal for how much to move (cut or fill)
each day.

- . 2 Trd
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Work with Activities

Creating Activities

Activities in WorksOS provide you with a project-wide method for quantifying
earthwork-related calculations. Using activities, members of a project have a way to
understand progress made on earthwork volumes based on a surveyed surface, design,
and start/end dates.

The % complete is calculated based on the progress made against the estimated volumes.
The work done should generally occur within the target dates to count towards the activity,
but work outside the dates still counts unless the activity is marked as Ended; this will
either happen automatically if the target volumes have been achieved or if you set the
actual end date manually. The target end is primarily of interest in calculating the target
working rate. Target volumes (as specified in the Ul) are used to determine when an Activity
has started (change from 100% remaining) and finished (0% remaining).

This new feature better matches the way you estimate, bid, and track the execution of jobs.
You could do this more manually in previous releases of WorksOS, but activities make it
easier by matching your existing workflows.

To configure activities, you must have a design and one or more surveyed surfaces (.ttm,
primarily from Trimble Business Center, SCS900, or Siteworks). In an activity, you can opt to
track areas on the site (such as cut vs. fill) or phases (such as overburden stripping and
unusable material removal). Use activities to divide areas and/or phases of work (even
sequential) prior to starting work.

Recommendation: Do not create activities that encompass your entire project. There is a
limit on the size of the cut and fill volumes (currently 10 million m?3).

1. Select n Map on the left. Then click [ custom Area on the right and draw closed
shapes to define any project areas that you want to use for activities, such as work
type (e.g., cut, fill) or phase (e.g., overburden stripping, unusable material removal)
boundaries.

2. Select E Activities in the left pane.

3. If the project has existing activities, review them in the Activities list before creating
new activities to see how the work is being broken down and planned so the team
can track progress and completions.

: \ 2 Trd
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Tip: You can also configure the Activities list to make columns visible, reorder
them, and pin them.

Each includes these parameters:

e Cost code - Optional data to tie together estimation and scheduling (see step
5 for details).

e Target start date - Dates are used for the job scheduling and estimation.
The target dates are also used to specify the working period for the activity.
The target start date is required and is used to calculate the target end date
when a daily working rate is used. This date also serves as the starting point
for calculating actual quantities.

e Target end date - Dates are used for the job scheduling and estimation. The
target dates are also used to specify the expected working period for the
activity.

e Actual start date - The actual start date is automatically detected based on
the data. This date is determined by the day in which the actual volume
remaining is different from the target quantity. This date can also be changed
or input by the user in the case of Activities starting early. For example, if a
machine does some work that is within the boundary of the activity and after
the target start date, this will automatically set the actual start date.

e Actual end date- Based on the range of when data first comes in from the
field, and when you specify that work is complete or the remaining volume is
0.0. If the work remaining does not reach zero you should set the actual end
date manually to store the correct status of the surface and end state for that
activity. This sets the working dates for the activity and changes the status to
Finished.

Note: You should set the actual end date if the work remaining does not
reach zero within the target start and end dates.

e Boundary - Shows names of the areas created in the Map view. Boundaries
are used to divide activities by the different phases or working areas. Highly
recommended that cut and fill areas are tracked separately when not a
balanced site.

e Estimate - Shows the total volumes to be worked in each area.

4. To create a new activity, click ADD.

5. Inthe right pane, enter:
e Activity name - Make this descriptive so other team members can easily
distinguish between activities.
e Cost code - Specify a cost code for the activity type. Entering codes is

] F";:'}F ]
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optional, but beneficial if you want to tie the estimation (when using Trimble
Viewpoint or Trimble Quest, for example) and scheduling (using Tilos,
Primavera P6, or Microsoft Project, for example) to your WorksOS project.
Cost codes are also used in the field when work is bid, executed, and
completed.

Activity type - Choose a calculation type. Only Earthworks is available today.
Activity subtype - Based on the selected activity type, choose a sub type:
Cut/fill, cut, or fill. These choices are used to quantify and calculate the
estimate, as well as track progress once work begins.

Note: For activities that are subtype cut only, the lowest pass elevation
filter is used to calculate volumes. This is important in case you compare to
other filters showing similar information.

e Surveyed surface - Choose an initial surface (typically existing/original
ground).

e Design - Select a target for the finished surface. Any imported surface can be
selected as the ending surface.

e Boundary - Refine your calculations by selecting a smaller, custom area. You
can create these areas in the Map view.

6. Click Calculate to see earthwork volumes broken down by estimated cut and fill
areas, as well as a volume total. You can always change any of the previously
specified parameters and recalculate without leaving the pane.

7. Review the Volume estimates in the same pane.
8. Click NEXT, and enter the Target start date.

9. Enter a Daily working rate (meter? or yard®/day) to indicate how much cubic
material can be worked in a day.

10. Enter a Target end date or calculate it based on the daily working rate specified
above. If the latter, adjust either the work rate or end date as needed.

11. Click Add to add it to the Activities list so all project users can see it. Once added,
the activity's actual start and end dates are calculated based on machine production
and surveyed data that WorksOS receives for the project.

Using the Activity Dashboard

As soon as you (or other project members) create activities for a project, an Activity
Dashboard becomes available. This dashboard can show data for all activities in the
project or for a single activity at a time.

] F";:'}F ]
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BTrimble WorksOS

Al Activities Compactor Area

Trench Main Pad Area

Westminster Test Strip

in Pad Area
ete

TargetEnd: 01131122

Total Remaining: 3,

Total Completed

Estimated Volume: 3.503.6 yd® (100%)

Crowned Road North
Complete

Start:09/01/2 Target End 1 01/13/24

18.08%

Total Remaining: 70.5

Total Completed

Estimated Volume: 86.5 yd® (100%)

Top of Slope 1
Complete
Start:09/01/21 End:01/17/22

94.38%

Total Remaining: 19,

Total Completed: 33

Estimated Volume: 3%<.1 yd® (100%)

Test Strip
% Complete

Start: 10119121

11.51%

Total Remaining: 3,100

Total Completed: 403.4 yd® (11.51%

Estimated Volume: 3,503.6 yd* (100%

Target End : 10/20/21

October Demo Days
9% Complete

s o192 Target End : 10/22/21
15.76%
Total Remaining: 3,100.2 yd® (84.24%

Total Completed:

Estimated Volume:

Compactor Area

Complete

Stare: 11/01/2 Target End : 05/07/22

29.04%

Total Remaining: 640.5 yd® (70.96

Total Completed:

Estimated Volume: 90,

November Gravel Delivery
Complete

Stare: 11115721 Target End : 12/31/21

15.76%

Total Remaining: 3,100.2 yd® (84.24%

Total Completed: 57

Estimated Volume: 3

Trench
% Complete

Start: 01/03/22

4.56%

Cut Remaining: 296.9

Cut Completed: 12.

Estimated Cut: 311

Target End 1 01/12/22

You can select a different activity to review in the list at the upper right.

Cut / Fill Map Targetvs Actua _ . ..

Seart: 09/2212

Use this dashboard to review these default widgets:

e % Complete - Review percentages for the remaining, completed, and estimated
volumes for the specified activity type and subtype.
e Work remaining - Shows the work yet to be completed broken down over the last

seven days (most recent 7 days or the last 7 days of a finished activity). If the activity
is not yet started, this shows the same value for each of the last 7 days.
Cut/Fill Map - Displays the visual cut/fill map for a single selected activity.
Target vs. Actual Working Rate - Actual work rate is the work done divided by the
actual working days. This shows you how much work is being done on average per
every day worked. Target work rate is the total work estimate/total calendar days to
complete the estimate. When Actual Working Rate is viewed for the first day of an
Activity this will count as a full day.

You can input a number for the Target Working Rate. This would match up to the
actual rate when you type in this number rather than deriving the target working
rate from two dates. This, in turn, calculates a date in the future that is calendar

days.
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Because the actual working rate is calculated using only the days when earth was
moved that matched the subtype of the activity, non-working/weekend days and
days when earth was not moved due to working on another area of the site are not
used.

Recommendation: Enter the Start Day and a target working rate, which will thus
compare a proper target vs actual working rate.

1. Select Dashboard > Activity Dashboard.

Classic Dashboard

Activity Dashboard

)

2. Review the Percentage complete widget:
a. % Complete - You can click the progress bar to open the cut/fill Map view of
the selected activity area.
Cut remaining - Calculated based on elevation data.
Cut completed - Calculated as (Estimated Cut - Cut Remaining).
d. Estimated cut - Estimated volume that was shown on the Create Activity
(1/2) screen (calculated based on the selected Survey, Target Design & the
Custom Area).

[N

3. Click the % Complete progress bar to open the cut/fill Map view of the selected
activity area. When you do this to from the progress bar to the Map, the Total
Remaining value on Activity Dashboard is consistent with the Total Volume value
in the Remaining tab, but the Total Completed value (on the Activity Dashboard)
may not be in sync with the Total Volume on the Completed tab (Cut Completed =
(Estimated Cut - Cut Remaining)).

SITE COMPOUND AREA

| ™
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Tip: Draw a profile through the activity area to see the progress of work based on
different surveyed surfaces versus the design.

4. Select a new activity in the list in the upper right.

5. If needed, click the = Filter icon to narrow activities on the dashboard to those
Started, Not Started, or Finished. Click Apply.

6. If needed, export the Activity Dashboard as a PDF by clicking the [_E Generate

PDF icon.

7. The Activity Dashboard widgets act as filters using the activities specific
parameters. When you click the progress bar to open the Map view for an activity
you can set additional filters, run queries, create profile views, and run reports.

Editing Activities

1. Return to the Activities view to edit the areas and/or dates specified for an activity
at any time. You can also end an activity if it is completed early, the quantity does
not reach 100% or if it is intended to leave a quantity remaining for future use.

2. Inthe Activities list, click the * More icon next to an activity to edit the
parameters or dates.

Target End Date Actual End Date Boundary Estimate

01/31/22 2,678.7 m? (Cut/Fill)

01/13/24 North Crown Road 66.1m  Edit Activity

03/31/22 01/17/22 Top of the Slope 270.7n  Set Activity Dates

10/29/21 2,678.7 Dup\icate?ctivity

10/22/21 2,813.6  Delete Activity

N H
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3. To end an activity manually simply specify the actual date ended.

An activity will only end automatically if the target volumes have been achieved, i.e.,
the volume remaining = 0. If the actual volumes never actually match the target
because less earth was needed to be moved to complete the activity, it will never
end. In this case, you should manually end the activity.

Generally, when activities are finished, their volumes are fixed; they cannot receive
any more progress towards their working rate, etc. Although data arriving after the
actual end date is ignored, any late-arriving data for a day before the end date will
update the activity. The result is that the progress on the activity dashboard widgets
can show non-100% progress for finished activities.

- . 2 Trd
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Data Exchange Workflows

Supported Data Types

Many types of information can be brought into Trimble WorksOS (both automatically and
manually) as files from a variety of office and field sources. These data types integrate into
WorksOS:

1. Trimble Earthworks machine productivity data (.tag)
2. Trimble GCS/PCS/CCS900 machine productivity data (.tag)

3. Trimble Business Center (TBC) projects (job sites) for WorksOS

4. Project data from TBC and manual imports:
a. Design surfaces (.ttm)
b. Linework (.dxf)
c. Alignments (.svl)
d. Surveyed surfaces (.ttm)
e. Drone Imagery (.tiff) - WGS-84 referenced
f. Calibration and coordinate system data (.dc, .cal)

F"__ -
TRANSFORMING THE WAY THE WORLD WORKS s >Trimble
5. Calibration and coordinate system data (.dc, .cal)

(3

{

6. Project boundary (.dxf)

See details for each type below.

s -
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Machine productivity (.tag)

Projects (for WM/WOS)
Linework (.dxf) —
Alignments (.svl)
Surveyed surfaces (.ttm)
Design surfaces (.ttm)

Trimble Earthworks
Construct with Machine Control

Trimble WorksOS
Monitor Progress, Productivity, & Quality

Linework (.dxf)
Alignments (.svl) t
Trimble Business Center Surveyed surfaces (.ttm)
Prepare Project and Design Data [™—— Design surfaces (.ttm) Accounts Machine productivity (.tag)

Users
Projects

Manual upload

&

ces.ccs.pes
All data exchanges are
made via the Cloud

Trimble CCS900,
GCS900, PCS900

Construct with Machine Control

Trimble WorksManager
Package and Transfer Data

Terminology

e 3D-enabled - A project type into which machine productivity data (.tag) files can be
processed. 3D-enabled projects must have boundaries that do not overlap with
other 3D-enabled projects. This type of project is fully functional in Trimble WorkOS
and WorksManager. For details, see the WorksOS Guide - Creating, Editing, and
Archiving Projects.

e Non-3D-enabled - A project type into which machine productivity (.tag) files cannot
be imported. Non-3D-enabled projects can have overlapping boundaries with other
projects. These projects are only used in WorksManager.

e Machine productivity data - Progress, productivity, and quality (PPQ) metrics
transmitted from machines on site to cloud and office apps via machine data files

(.tag)

e As-at state - Ground truth at a specific moment in time, such as for the in-progress
status of a surface

" W
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Bringing in data/files

Automatic method (processing)

Machine productivity data (.tag) from Earthworks and GCS/PCS/CCS900 automatically flows
into WorksOS 3D-enabled projects and is immediately processed. This data can also be
manually imported.

Manual method (importing)

Machine productivity files (above), as well as design surfaces, linework, alignments, and
surveyed surfaces, can alternatively be imported manually into a project. Once your click
Imports > Import Files, there are three options in the side panel:

< Import Files X

Import multiple .TTM, .SVL, .DXF or
TAG files at once fram
WorksManager or local storage.

WorksManager Browse

Local storage

=3}

Import from WorksManger

You can import any compatible files from WorksManager into WorksOS as a one time
import. DXF files and .ttm design files that have been loaded as data collector designs in
WorksManger can be brought in. This is the only shared compatibility for file imports. The
file name appears first, then type, design and version followed by the name of the user
who imported in WorksManager and the date imported. Each time a new version is
updated, this data will appear as another import in WorksOS and be overwritten only when

" W
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you choose.

Import data from Local Storage by browsing or drag-and-drop

1. From either the Dashboard or Map Screens for the currently selected project, click
the More (ellipses) icon and select ‘Imports’ in the menu.

Morth Lot Cut (Started) I: E

Dashboard

Imports @

This will open the Imported Files screen which shows all currently uploaded files in
the project.

Imported Files X

IMPORT FILES

£ Alignments (0)
[ Designs (5)

CJ Drone Imagery (3)
] Linework (4)

[ surveyed Surfaces (2)

2. Click the + button to open the Import Files window. From here, you can manually
browse or drag-and-drop each file type you want to import into the Project.

3. Select machine productivity files (.tag) to import them into the project. The imported
data is checked to see that it lies within the spatial extents of the project boundary.
Any data outside the boundary is not added.

4. Select design surfaces (.ttm), linework (.dxf), alignments (.svl), and surveyed surfaces
(.ttm) to import into the project. Once imported, these files are displayed in the
Import Files list where you can view them by file type and disable or remove them if
needed.

Note: Tag files cannot be automatically or manually imported into non-3D-enabled

projects.
Eow "
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1. Earthworks Machine Productivity Data (.tag)

Earthworks machine productivity data can flow automatically into WorksOS and can also be
manually imported into 3D-enabled types of projects.

Note: Tag files cannot be automatically or manually imported into non-3D-enabled
projects.

For the data to flow into WorksOS, the Earthworks device (e.g., EC520) must have a device
license in WorksManager (in the same account used by the WorksOS project). See the

WorksManager support/documentation on how to set up a device in the WorksManager
account.

Once your device(s) have been set up in WorksManager, the data will flow to WorksOS and
be accepted or rejected based on the project requirements. A Trimble Connected
Community (TCC) license is not required to run Earthworks.

Data from Earthworks can also be manually imported into WorksOS if required. In the
Imports sections, simply select or drag-and-drop a folder into the Import dialog. No further
selections are required and the user can select import once all file(s) are selected.

103 Tag Files X

Cancel Import

2. GCS/CCS/PCS900 Machine Productivity Data (.tag)

Trimble GCS/CCS/PCS machine productivity data can flow automatically into WorksOS and
can also be manually imported into 3D-enabled types of projects.

For the data to flow into WorksOS, the Earthworks devices (e.g., CB450, CB460) must have a
device license in WorksManager (in the same account used by the WorksOS project). See
the WorksManager support/documentation on how to set up a device in the
WorksManager account.

Once your devices have been set up in WorksManager, the data will flow to WorksOS and
be accepted or rejected based on the project requirements

: \ 2 Trd
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Note: A TCC license is still currently required for Trimble GCS/CCS/PCS900.

Data from Trimble GCS/CCS/PCS 900 can also be manually imported into WorksOS if
required. In the Imports sections, simply select or drag-and-drop a folder into the Import
window. No further selections are required and the user can select import once all files are
selected.

103 Tag Files *

Cancel Import

Note: Tag files cannot be automatically or manually imported into non-3D-enabled
projects.

3. Project Data From Manual Import

3a. Design surfaces (.ttm)

Design surfaces can be manually imported into a WorksOS project as a Trimble
Triangulated/Terrain Model (TTM/.ttm).

Ideally, the exact design prepared in WorksOS should be sent to the machine in the field so
they have the same definition and can map progress and productivity consistently. Design
surfaces use X,Y,Z coordinates for length, width, and height (elevations) dimensions.

Importing a design in the Imports window requires you to choose whether the TTM is a
design surface or surveyed surface.

Dimensions Design.ttm x

Design

Surveyed Surface

Cancel
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Once imported, a design appears as a blue, closed polygonal boundary on the Map screen.
Boundary filtering can be used on a design to show only data inside the boundary. Design
surfaces can also be used for Work Remaining cut/fill and volume calculations required to
achieve the Finished Design surface.

3b. Linework Files (.dxf)

Linework can be manually imported into a WorksOS project as a .dxf (a universal CAD
exchange format) .

Linework provides you with visuals and guidelines for what a finished surface, structure, or
area could look like when finished (or as a plan view while it is being built).

When importing a linework file through the Imports window, you must select the unit type
in which the file was created in the source program (e.g., TBC). Selecting the wrong units for
the data will cause linework to be displayed in the wrong place.

Dimensions Linework.dxf -4

Linework

Imperial

Metric

US standard Cancel

Once you have imported linework, it will appear on the Map screen in its original colors.
Linework files can be large, varied, and detailed to render and upload. In WorksOS, they
are for visualization purposes only, i.e., to show what a virtual finished
surface/road/project could look like. You cannot filter or interact with the data in any way.

Ph 1
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3c. Alignment Files (.svl)

Alignments can be manually imported into a WorksOS project as an .svl (a native Trimble
Sitevision linework format). An alignment file contains an alignment centerline plus
stationing/chainage (distance) start and end values within it.

Once alignments are imported, they appear as red lines on the Map screen, complete with
stationing/chainage labels. Alignments can be very long and typically represent one or
more road centerlines, i.e., the center of a new road being built.

Alignments are used to spatially filter and report data for what is typically a road building
project (as the alignment is the centerline of the new road).

- - — = -ﬁa

=

S
o
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The Alignment Filter allows you to select an alignment file and spatially filter the data for a
set distance along it (which can be part or all). You can also specify how wide to sample left
and ride of the centerline, e.g., to encompass one or more traffic lanes.

Example:
b, .
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Alignment File

Start/End Stations

o

Left/Right Offset

The Station & Offset Report uses the same spatial filtering method to select data and also
to specify the frequency at which you want to sample it in the report.

3d. Surveyed Surfaces (.ttm)

Surveyed surfaces can be manually imported into a WorksOS project as a .ttm file.

A surveyed surface may come from a survey device, data collector, or drone; it represents a
surveyed area at a given point in time and is used as a source of truth for the ‘as-at’ state of
the surveyed project area.

Surveyed surfaces combine with machine productivity data to form a composite surface
where there are no spatial overlaps between the two. If machine productivity data and
surveyed surfaces overlap spatially, then the most recent of the two supersedes the other
in the composite surface. The date/time of the surveyed surface and the date/time for
machine data are taken into account when producing the composite surface. There are
data filter settings in WorksOS that can also control the two surface types.

Importing a surveyed surface in the Imports window requires you to select whether the
.ttm file is a Design Surface or Surveyed Surface.

- . 2 Trd
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TRANSFORMING THE WAY THE WORLD WORKS

Dimensions Design.ttm X

Design

surveyed Surface

Cancel

Once you choose a surveyed surface, you are prompted for a Survey Date/Time which
determines the ‘as-at’ date/time for the surface. Any other data that overlaps spatially with
this surveyed surface will either supersede or be superseded by it, depending on its own
date/time.

Original Ground Survey - Dimensions 2012.ttm X

-

Surveyed Surface

Cancel

Once imported, surveyed surfaces only appear visible on Elevations, Cut/Fill Quality
Metrics, and in Volumes Calculations. They contain no pass counts, compacted meter value
(CMV), temperature, machine drive power (MDP), or speed values, so they are not visible in
those quality metrics and the detailed data view (DDV) tool does not pick them up either
(shows machine data only).

Surveyed surfaces are imported:
e For the original ground topo survey (a starting point of the ground in the project)
e For periodic surveys during the project to state the ground “as-at” a certain time.
e To improve bad or missing machine productivity data
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4, Calibration/Coordinate System Files (.dc, .cal)

Calibration/Coordinate system files can be published automatically through TBC's Publish
to WorkOS command or manually imported into WorksOS at the time of project creation
(or when you edit it in the CONFIG FILES tab as a .dc or .cal format).

The file should be the same file as used by the devices/machines submitting data from the
field to ensure data accuracy. The coordinate system/calibration file can affect all other
project files and machine productivity data.

Note: Once you have device/machine productivity data for a project, it is recommended
that you do not change its coordinate system.

Create New Project X

PROJECT INFO CONFIG FILES

CONFIGURATION FILES

Files can always be added after a
project is created.

Calibration
+
"Ek .dc .cal
Boundary +
% Jdxf

You must have a calibration file selected to
enable a Boundary Polygon to be used as a
Project Boundary.

s ]
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5. Project Boundary from a File (.dxf)

Project boundaries can be imported as a .dxf file when you create a project or edit its .dxf
file in the CONFIG FILES tab.

The .dxf file must contain one closed polygon to create a valid project boundary. The
calibration/coordinate system file must be uploaded before selecting the boundary .dxf file.
In the Create/Edit Project > BOUNDARY step, the boundary contained within the .dxf is
displayed on the Map before you finish creating the project.

Create New Project X
PROJECT INFO CONFIG FILES
CONFIGURATION FILES

Files can always be added after a
project is created.

. Calibration +
* .dc .cal

. Boundary +
e .dxf

You rmust have a calibration file selected to
enable a Boundary Polygon to be used a3 a
Project Boundary.

Once selected in the Create or Edit Project > CONFIG Flles step, the polygon in the .dxf file
is displayed as the project boundary in the Project Type step. No further selections are
needed once you have imported a project boundary.

b -
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Project Type X

Project Type ~

Note: A boundary from a .dxf file cannot be edited once it is imported into WorkOS as
the project boundary. To change a project boundary from a .dxf, you must correct the
.dxf file in the source program or create a new one and upload it in the CONFIG FILES
step of create and edit project workflows.

h:“h 1
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Import, Export, & Report

Imports

Many types of information can be brought into Trimble WorksOS (both automatically and
manually) as files from a variety of office and field sources. You can import design surfaces,
surveyed surfaces, and alignments/linework into a project. You can also manually import
production files if needed.

Use these files to compare data to the machine productivity data to determine progress,
productivity and quality on the site. These data types integrate into WorksOS:
1. Trimble Earthworks machine productivity data (.tag)
2. Trimble GCS/PCS/CCS900 machine productivity data (.tag)
3. Trimble Business Center (TBC) projects (job sites) for WorksOS
4. Project data from TBC and manual imports:
a. Design surfaces (.ttm)
b. Linework (.dxf)
c. Alignments (.svl)
d. Surveyed surfaces (.ttm)
e. Calibration and coordinate system data (.dc, .cal)
5. Calibration and coordinate system data (.dc, .cal)
Project boundary (.dxf)
7. Drone imagery (.tiff)

o

See details for each type below.
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Machine productivity (.tag)

Projects (for WM/WOS)

Linework (.dxf) —
Alignments (.svl)
Surveyed surfaces (.ttm)
Design surfaces (.ttm)

| A
(X
Linework (.dxf)

Trimble Earthworks
Construct with Machine Control

Trimble WorksOS
Monitor Progress, Productivity, & Quality

Alignments (.svl) ,
Trimble Business Center Surveyed surfaces (ttm)
Prepare Project and Design Data [™\—— Designsurfaces (.ttm) Accounts Machine productivity (tag)
Users
Projects

Manual upload

&

ces,ccs,pes
All data exchanges are
made via the Cloud

Trimble CCS900,
GCS900, PCS900

Construct with Machine Control

Trimble WorksManager
Package and Transfer Data

For more information, see WorksOS Guide - Data Exchange Workflows.

Import Screen Options

View Selected (number of files) - Click to open the Selected Files list.

Selected Files - Shows all of the imported files available to the project. Click Clear All
to remove selected files.

+ Add button - Click to open the Import dialog to bring in new files

x Delete - Click to remove a file from the project and Selected Files list.
Check/uncheck boxes to make the data active/inactive in your project.

= Trimble Dimensions 2012
. Selected Files X
< Linework (3) X —
7 file(s) selected Clear All
View Selected (7)
Dimensions Linework.dxf X
B File Name Imported Date Imported By Last Modified On
[ Milling - Designiap.dxf 07/22/20 19:40 @trimble.com  07/22/20 19:40 % =
Dimensions Linework.dxf 07/22/20 19:40 @trimble.com 07/22/20 19:40 >
=
- Trimble Command Center - X
Trimble Command Center - DesignMap.dxf ~ 07/22/20 19:40 @trimble.com 07/22/20 19:40 X DesignMap.dxf
Linew K

FEEDBACK

Milling.svl X

..i‘
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Import Project Files

Project files include designs, alignments, linework, and surveyed surfaces, i.e., files specific
to your project.

1. On the Actions bar, click the * More icon and select Imports.

2. Click any of the folders (Alignments, Designs, Linework, Surveyed Surfaces) folders
to see what data you already have that is being used in the project.

o Design Surfaces - You can also pull in all of your design surfaces from
Business Center so you can determine how much work remains to achieve
the design.

o Linework - If you also pull in linework and geofences from TBC, and compare
them to the finish grade design, this will tell you how much work is remaining
to complete.

o Surveyed Surfaces - You can compare an as-built surface to the original
ground surface from a survey. This volume comparison tells you how much
work has been done since the original survey.

3. Thenclickthe - button and either:
o Browse to and select the files you need.
o Drag-and-drop supported files (.tag, .dxf, .svl, and .ttm) from your Windows
Explorer into the folders. This allows you to bring in entire folders of TAG
files.

You can select multiple files of any type at once to import them simultaneously.

Import Surface Files (.ttm)

You are prompted to specify whether the file is a:
Surveyed Surface

1. Select a Surveyed Date and Time by clicking on the date icon.

2. Choose a Custom Date.

3. Select the Day and define the time when the survey was completed.
4

Once the processing is complete click Finish. Newly imported surveys are
active by default as part of the Selected Files.

Optional Additional Working Items
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5. Deselect the Survey from the project by clicking on the Survey name within
the Selected Files Section.

6. Click Remove. This will keep the Survey as part of the Imported Files for the
Project that are currently inactive.

7. Click on the Survey from underneath the Imported Files.
8. Click on Add to make this Survey active within the project.

The date and time selected must be the date/time of when the survey was
taken. This will be used to define when the survey elevations are used vs
recorded machine data. Then select the date it was surveyed. Machine
productivity data that comes in after this date will replace it as the latest
surface.

Design Surface

1. Import a design file (.ttm only) by dragging and dropping the file into the top
of the window or click “New Import” to browse your computer for a design
file.

2. Under File type select “Design” to treat the .ttm as a design within the
software.

3. Add in additional files if desired. Click Import to begin the importing of the
file(s).

4. Once the processing is complete click Finish. Newly imported Designs will be
active by default as part of the Selected Files.

5. Deselect the Design from the project by clicking on the Design name within
the Selected Files Section.

6. Click Remove. This will keep the Design as part of the Imported Files for the
Project that are currently inactive.

7. Click on the Design from underneath the Imported Files.

8. Click on Add to make this design active within the project.

Import Alignment Files (.svl)

An Alignment File requires no additional setting once selected for Import.

Import Linework Files (.dxf)

You are prompted to specify the type of units used when the linework was created.
1. Newly imported Linework will be active by default as part of the Selected Files.
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2. Deselect the Linework from the project by clicking on the Linework file name within
the Selected Files Section.

3. Click Remove. This will keep the Linework as part of the Imported Files for the
Project that are currently inactive.

Click on the Linework from underneath the Imported Files.
Click on Add to make this Linework active within the project.

To Delete the Linework from the Project, click on the “x” next to Linework.

N o v &

Confirm by clicking Delete. (Cancel if you want to keep the imported file within the
project.

4. Do not close the window until all files have been imported.

5. When files have been processed, click Finish, and confirm that the imported files
appear in the appropriate folders. The data in these files is ready to use!

6. To make a file inactive in the project, uncheck its box.

7. Toremove a file from the project, click the x to the right of the file name.

Import Production Data (.tag)

1. To import TAG (.tag) files, click the * More icon on the Actions bar and select Imports
> Production Data.

2. Browse for files or drag and drop them from your directory into the Import files
field.

3. Do not close the window until all files have been imported. When files have been
processed, select Finish.

Note: For linework files, you must also select the type of units used when creating
the linework. For .ttm files, you must also select the file type.

4. Select Import when done.

5. Do not close the window until all files have been imported. When files have been
processed, select Finish.

6. Inthe Project Files window, ensure the imported files appear in Selected Files.
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7. Toremove a file from the project, select the file and select Remove. To remove a file

permanently from WorksOS, select the file and select the Delete icon x.
8. Click Save.
hn ]
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Import Drone Imagery (.tiff)

You can import GeoTIFF files (.tiff format with raster orthoimagery from Trimble Stratus or
other 3rd party software) into WorksOS. After import, you can use a GeoTIFF as the
background image for your project over the map. As your project progresses, you can
import additional GeoTIFFs of the same area that show the different phases of work being
completed. The most recent image is the default top image. When you change the date of
your view, the corresponding drone image will appear.

GeoTIFFs are raster images with georeference and geocoding information. WorksOS uses

just the orthoimagery data in the file, not any survey data.

1. To import GeoTIFF files (.tiff) files, click the * More icon on the Actions bar, and select
Imports.

Ph 1
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2. Select Drone Imagery and click IMPORT FILES.

3. Click Browse next to Local Storage, navigate to the GeoTIFF file you need, and click
Open.

4. Specify the date and time the drone imagery applies to (when the flight was made).

Tip: As a best practice, have the drone operator or Stratus tech name the file
using this data and time.

Note: GeoTIFF files can take hours to import, so choose the appropriate file
carefully. During the import process you can see the stages in the Notifications
pane.

Note: GeoTIFF files must be in WGS84 coordinate system format (not Local grid
or DTM) to be valid in WorksOS. Stratus also supports multiple other formats.

5. Click Import. Once imported, the image will persist as your project’'s new
background image.
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Note: As your project progresses, you can import additional GeoTIFFs that show
the different phases of work being completed. The most recent image is the
default top image. When you change the date of your view, the corresponding
drone image will appear.
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6. To hide all drone imagery, click the * More icon on the Actions bar, and select
Settings > Map.
- / ; ’I. 1 E 3

< Drone Imagery (3) X

IMPORT FILES

o)
P

".;', i ) 3(_11'?:_?___321.{‘” %

@) 2017_8_24 - WorksOS X
Successful uf

@@ Trimble Westminster PH2 20179 X
1.uf

7. Toggle Drone imagery off. You can also hide individual drone images by
toggling them off in the imported files pane shown above.

Import Designs from Trimble WorksManager

To complement new shared project functionality in WorksOS and WorksManager, you can
now easily import existing designs from WorksManager to use when performing progress
calculations directly within WorksOS. When you connect to the same project within
WorksManager, you can see the most recent version of all the designs that exist within the
selected project. This workflow will help if you routinely send surfaces and linework to your
data collectors in the field.

See the demo video here: WorksOS Tutorial - Import from WorksManager

Note: Any/all edits to designs imported via WorksManager must be made within
WorksManager.

Warning: Currently, you are not notified when a newer version of a design is available in
WorksManager.

Note: All surfaces are designs at this time.
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To import surface (.ttm) and/or linework (.dxf) files directly from WorksManager:
1. In WorksManager, open a project that is shared with WorksOS.

2. Select Designs and confirm the TTM and DXF files you want to import into WorksOS.

3. In WorksOS, open the same shared project.

4. On the Actions bar, click the * More icon and select Imports > Import Files.

5. Click Import Files from WorksManager. All of the files that you can import are
displayed.

< Import Files X

Import multiple .TTM, .SVL, .DXF or .TAG
files at once from WorksManager or loca

storage.

WorksManager hnruwse

Local storage

o Any files that have already been imported from WorksManager will not
appear here, but they do appear on the Selected tab.
o Newer versions of already imported designs will appear as files that can be
imported.
o Each file shows its design name, version, and extension.
o The date of creation/update comes from WorksManager.
m The creation date is the modified date for the first version.
m The modified date is the last time the file in WorksManager was
modified, thereby updating its version.

6. Check the box for each file to be imported to add it to the Selected tab.

Note: WorksManager is designed to send files to machines, so a TTM is typically
not loaded unless going to a rover. The File Flipper utility can convert files for
machine use but not vice versa.
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7. Click the Selected tab to verify the files to import.

8. Click Import.

9. For each DXF file, select the measurement unit (Imperial, Metric, or US Survey).
10. Click Import again.

11. Once the import is complete, select Actions > Imports > Designs and Linework to see
the files.

Exports

You can export design surfaces, surveyed surfaces, and alignments from a project to be
used in other applications. Three types (surface, machine passes, and VETA) can be
exported.
e Toview machine data in Trimble Business Center (TBC), export Surveyed Surface
files. This enables you to compare as-built surfaces to the design in Business Center.
e To export raw pass-count data, export Machine Passes.

Export Files

1. Click theﬂMap icon on the left side of the screen.

2. On the Actions bar, click the * More icon and select Settings > Exports.

3. Select one of the following:
e Surface
1. Enter the export file name (without spaces).
2. Enter the vertical tolerance to convert the grid into a triangular
irregular network.
3. Select the required filter.
4. Click Export. WorksQOS exports the surveyed surface data as a .ttm file.
5. Download the zipped file and import it into TBC.

e Machine Passes
1. Enter the export file name (without spaces).
2. Select a Coordinates option:
o Latitude/Longitude - Export for a global, Earth-Centered
Earth-Fixed coordinate system.
o Northing/Easting - Export for an X,Y,Z Cartesian coordinate

system.
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3. Select an output option:
o Last pass only - Output only includes data for the final pass
over each cell.
o All passes - Output includes a line entry in the output file for
every pass over every cell.

4. Select the required filter.

5. If required, select the exported file (.csv) options:

e If you do not restrict the output to a maximum of 65535 rows
per file, then the output will be a single zipped .csv file that
includes an unrestricted number of rows.

e If you select Output raw data in dbase format, the units that
are selected are included as column headers in the output. If
you do not select this option, then the units are included in
each cell.

Note: The Machine Passes export has been formatted for easier
importing into Trimble Business Center (TBC) as a CSV Point Cloud
file. The following fields have had their units removed from each
individual cell so the raw values are correctly formatted for manual
import into TBC.

"CellN" for Cell Northing, "Cell E" for Cell Easting, and "Elevation" have
all their units removed.

A
1 Time CEIIN CEIIE Elevatl F"ESSNI
2 Eﬂlzfﬁctf 1163. ﬁﬂté 2741. 55 594. 836

They now only display in the column headers.

Time CellN(m) Cellg (m) -Elevation (m) -I
Izmzfoct,ﬂ 1163.99 !2?41.59 594.837

Note: If you automatically or manually import these CSV files
elsewhere, please be aware of the formatting change.

e VETA - See Export to VETA below.

7. Select Export.

8. Download the zipped file.
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Export to Veta

To export data specifically for Veta Data Management and Analysis software, select Veta.

For more about Veta, visit Veta Data Management and Analysis Software.

Note: Export to Veta exports only dates / times and filtered compactor machine data
from the map. If you are not exporting data specifically for Veta Data Management and
Analysis software, select Machine Passes instead.

1. Enter a file name or accept the provided file name.

1. Select a Coordinates option:
o Latitude/Longitude - Export for a global, Earth-Centered Earth-Fixed

coordinate system.
o Northing/Easting - Export for an X,Y,Z Cartesian coordinate system.

2. Click Export.

3. Download the file for import into VETA Data Management and Analysis software.

Reports

WorksOS reports provide information to members of organizations who may or may not
use WorksOS to receive critical data. You may need to allow pop-ups (disable the pop-up
blocker) in your browser before the report can be generated. Three reports (summary,

station/offset, grid) are available.

Generate reports

1. Click the ﬂ Map icon on the left side of the screen.

2. On the Actions bar, click the * More icon and select Settings > Exports > (one of
these reports):

e Summary - A snapshot of the map on screen and a pie chart for the selected
Quality Metrics. This report is used to share any 3D productivity data.

a. Select the raw Quality Metric (you can choose multiple).
b. Select a Favorite filter or current filter (default).

e Station & Offset - A statistical report used for roading projects. This report
reports raw machine values instead of a Quality Metrics summary. Using an

: \ 2 Trd
TRANSFORMING THE WAY THE WORLD WORKS “s:*TI'II'I'Ible.

WorksOS - User Guide 140


https://www.intelligentconstruction.com/veta/#:~:text=Veta%20can%20import%20data%20from,formats%2C%20including%20graphs%20and%20maps.

imported Alignment file (such as a road centerline), you can select spatial
areas to report raw machine values for.

a. Select the raw Quality Metric (you can choose multiple). If you select
Cut/Fill, select the Design. You can select more than one Cut/Fill
metric.

b. Select the Alignment file.

c. Enter the Start Station and End Station values for the Alignment file
(up to three decimal places).

d. Enter the Cross Section Interval value for reporting frequency (up to
three decimal places).

e. Enter the Left Offset and Right Offset values to the left and right of the
Alignment centerline. You can enter multiples of each (up to three
decimal places).

f. Select a Favorite filter or current filter (default).

e Grid - A statistical report used for any construction project. This report
reports raw machine values instead of a Quality Metrics summary. You can
select and rotate spatial area grids of data to report raw machine values for.

a. Select the raw Quality Metric (you can choose multiple). If you select
Cut/Fill, select the Design. You can select more than one Cut/Fill
metric.

b. Enter the Grid Interval value (up to three decimal places).

c. Select the Grid Origin (Automatic or Manually Define). If you select
Manually Define:

m Enter the Grid Origin in Northing/Easting values (up to three
decimal places).

e Enter the Grid Rotation in Northing/Easting values or an
Azimuth in degrees value (up to three decimal places from
0.001 to 360.000).

3. Click Download.
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Workflows for Scenarios

Workflows for Specific Scenarios

Compare Surfaces and Calculate Volumes

Surfaces in WorksQOS are either created in other programs, such as TBC, and imported as
.ttm files or created when .tag files are processed when they automatically come into
WorksOS.

Using your machine control system’s GNSS (GPS) data, WorksQOS accurately maps the
locations and elevations of every place your machines work. From that data, you can
generate an as-built surface, which is the last pass of a machine creating the final surface of
the day. Then, you can compare that last as-built surface to a previous as-built surface.

Based on the change/difference between the two surfaces, you can calculate the volumes.
Anywhere the elevation went down is cut and anywhere it went up is fill, so you can also
generate a cut/fill map. check

1. Navigate to the Map view.

2. Click the Selected Filters icon.

3. Expand the Date Range section, select Project Extents, and click Apply.
4. Click the Metrics fly-out and choose Volume in the list.
5

Choose to calculate based on the Filter you selected or select Design/Surveyed
Surface and choose the surface in the list.

o

Click Calculate to run the calculations.

7. Inthe Quality Metrics pane, review the Completed and Remaining volumes
(deficit or surplus, total, area covered by machines, and material density
percentages (if applied).

Calculate Cut and Fill

1. Select the design you want to base cut/fill or volume calculations on.

2. Review the cells colored based on cut and fill depth targets. You can configure these
colors in Project Settings.
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3. Use the Profile tool to see depths and percentages of cut, fill, and on grade between
surfaces along the profile line.

4. Change the selected design surface in the Metrics pane to see the cut/fill map for a
new comparison.

Create a Reference Surface File

You can create a reference surface file by applying a positive or negative elevation offset to
an existing design file. You can use this newly created reference surface file as a Design
Boundary filter, and to complete Cut/Fill maps and Volumes calculations at an offset from a
finished design.
1. To create a reference surface file, in the Import Panel, click on the Actions
Menu next to the design name and Select New Reference Surface.

2. Inthe pop up, enter either a negative value (preceded by a minus sign) or a
positive value. When you save it, a new reference surface file is created and
given the selected design file name appended with the elevation offset value.
This reference surface file now can be used anywhere a design file can be
selected.

3. (Optional) Change the Name of your offset within the File Name.

Note: You can create multiple reference surface files from a design file as
long as their offsets are unique negative or positive values. You can delete a
reference surface file, but you cannot delete a design file if any reference
surface file created from it still exists. You must first delete the reference
surface file(s) before deleting the design file.

Calculate Compaction Metrics

Use the Dashboard to see summary values for various comaction metrics like speed, pass
count, temperature, CMV, and CMV % change. The Dashboard widgets show summary
values that are based on targets that come from a machine or are set here in WorksOS.
These values can be filtered to a specific design boundary area.

1. Click a Dashboard widget to open the Map view using the same filters.
2. Select different compaction metrics in the list.

3. See descriptions in Filters You can Apply and View Quality Metrics and Coordinates
for a Cell.

o Pass count - For Summary values, the pass counts are mapped anywhere you
have a target set up, whereas Details are mapped regardless of whether you
have a target set or not. Details show percentages of each of the pass count
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ranges you have set up, which can be configured in Settings > Project >
Custom (targets). You can use the profile tool to see a profile of the quality
metric. The color of the line shows not only the elevation, but the pass count
in that location.

WorksOS shows a Pass Count Summary where the machine has a target Pass
Count setting (if applicab;e). Using that or setting a target in Pass Count
Settings will populate data in Pass Count Summary. The Profile line is colored
the same color as the cells that have been profiled. The color of the cell
determines how many passes it has, also clicking on the cell node (or turning
on Cell Markers and clicking will also reveal this info).

o CMV - These values are mapped three different ways:
m Details shows the raw CMV reading from the machine; i.e., the last
pass for the filtered data.
m  CMV % change maps the difference in CMV percentage between the
most recent pass and the previous pass. This helps you identify where
CMV is decreasing from pass to pass.
m  Summary values map the CMV values according to the targets you set.

o Machine Drive Power (MDP) - This value, which is not used on vibraroty
compactors, shows colors for on target (within a threshold) or over/under the
target.

o Speed - Machine or GPS speed (whichever is available) is mapped according
to a target threshold’s summary values. Speed considers all passes, so
anywhere outside of tolerance will be colored as outside of the target
threshold. Only areas where every pass was on target are mapped green.
Blue trumps green and red trumps blue. This is a key metric for vibratory
roller in achieving quality compaction.

o Temperature - Mapped according to an asphalt temperature threshold. The
last pass (within the specified filter) is always shown.

Track Progress Volumes

A preconfigured set of daily calculations and three views enable you to easily see the
volumes of cut and fill materials moved on your job site on a day-over-day basis. These
progress volume features allow you to analyze earthmoving progress during any time
period you specify and in any project area you choose.

The data for progress volume views comes from both machine TAG (.tag) files and surface
surveys (.ttm). When importing a .ttm file for progress volume calculations, always specify
that it is surveyed surface and select the data and time to which it applies; doing this
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timestamps and dates the survey data to align it with any machine data that is
automatically imported in the same time frame.

If you have applied material density (shrinkage and/or bulkage) factors for materials, the
reported volumes reflect this.

Note: Progress volumes functionality is not connected to the other Dashboard and Map
screens, i.e., the Dashboard does not account for progress volumes; this means the
dashboard calculations (other than Today or Yesterday) will not match progress volumes
as the filter setup and calculations are different on the dashboard.

Dashboard Configured for Progress Volumes

Click the Dashboard icon on your left-hand navigation bar in WorksOS to access the
Dashboard, which is configured for progress volumes. The dashboard automatically
includes these five dynamic Work Completed date range widgets that support progress
volume calculations:

Work Completed - Today

Work Completed - Yesterday

Work Completed - Current Week

Work Completed - Previous Week

Work Completed - Project Extents

R Trimble WorksOS # e

Dashboard =0

Work Completed - Today =0; Work Completed - Yesterday =0; Work Completed - Current Week = o: Work Completed - Previous Week = o;

Progress from end of yesterday to today Progress from before yesterday to end of yesterday Progress from end of previous week to end of cun

Progress from before previous week to end of pre,

2,249.0m 1,404.5¢ 2 2 12,551.8m 1,490.8¢» : 2 24,832.3m
Fill Completed Cut Complete: Fill Completed

e o Cu 4
844.5(m 3,653.6( 10,086.5(m 10,457 4 ﬂ 1,061.0em 14,042.6(wm
Surplus Total Volume Surplus Total Volume Surplus Total Volume

Last Updated: 03/09/21 04:06 PM Last Updated: 03/09/21 04:06 PM Last Updated: 03/09/21 04:06 PM Last Updated: 03/09/21 04:06 PM

Fill Completed

Work Completed - Project Extents = LH

Progress from start of Project to end of Project

26,1 ) 32,869.8m)

Fill Completed

cur
-6,674.9
Deficic

Last Updated: 03/09/21 04:06 PM

Default project dashboard

These represent total cut and fill quantities for the specified time periods. With just a
surveyed surface, e.g., Original Ground, as soon as your machines start working, the daily
or weekly difference from time frame to time frame can be calculated.
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You can also add a Work Remaining widget, which is always relative to a specific design that
you imported. This design gives you a surface to compare to.

The widgets are built from existing filters.

Filters X
Date Range A

Today Yesterday
Current Week
Previous Week

+/ Project Extents Custom

Favorite Filters -

Views for Progress Volumes

There are three types of views of for progress volume data:

e Graph view - A bar chart of cut and fill volumes broken down by day or week helps
you see the trend of material volume movement in your project area, Each bar is
separated into cut and fill colors representing the volumes moved. Hover over or
click any bar chart for details on the exact cut and fill volumes for that day or week,
as well as the cumulative volume for the project up to that time. The chart also
includes a line graph of the cumulative volume over time for the date range you
have selected. Scroll in/out in the view to see fewer or more days in the view.

e Grid view - An even more detailed table of values sorted by date allows you to see
the exact cut, fill, total, and cumulative values for every working day. You can also
export this grid to an CSV file for greater data analysis and visualization in
Microsoft® Excel.

e Map view - A birdseye/plan view of your project geographically that shows all the
areas in which material has been cut or filled over the entire project time period. To
see a smaller set of progress volume data, you can reduce the date range or spatial
boundaries shown in the map view.
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Accessing the Progress Volume Views

1. Click the Progress Volumes icon on your left-hand navigation bar in WorksOS to

access.
Dashboard
Work Completed Today =0; Work Completed - Yesterday =90;
rogress from end of yesterday rogress from before yesterday to end of yesterday

2,249.0m 1,404.5wm 10,272.0im

Cut Completed Fill Completed Cut Completed Fill Completed

3,653.6(my 10,086.5¢m 10,457 4wy

Total Volume Surplus Total Volume:

Last Updated: 03/09/21 04:06 PM

Trimp

Map View

Total Vg

h = %
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Graph view

The Graph View shows every day, start to finish. You can see here linear progression (bar
charts) over the weeks. This can help you track the consistency of material volume
movement as you normally would in the field (How much material was moved?) In addition,
the black line with dots shows the cumulative material volume. Click any bar to see the
daily cut, fill, and cumulative volumes.

bTﬂmbIe WorksOS Trimble Westminster Project 5 e

Custom 06/12/17 - 06/30/17 =

Trimble Westminster Project Progress Volumes

tal Volume: 65,432.5 m? | Total Fill: 41,276.2 m? | Total Cut: 24,156.3 m?

= DALY ¥

— CumulativeVolume @ TotalCut @ Total Fil
Daily Volurme (m3) Cumulative Volume (m?)
20,000 70000

18,000

16,000

14,000 50,000

12,000
40,000

10,000

8,000

6,000

20,000

4,000

10,000

0612117 061317 o6/14/17 061517 06617 0617117 o687 o6/t9/17 0620117 0621117 0622117 0623/17 062417 0625117 06/26/17 06127117 0628/17 06120117 0630117

Progress volumes daily graph

Graph View functions

The chart is configurable with a limited number of filters:
e Daterange
e Spatial such as boundary, alignment, or custom area

b -
TRANSFORMING THE WAY THE WORLD WORKS ‘;@‘.‘Tl‘lmhle.

WorksOS - User Guide 148



The chart is dual axis and includes three scales:
1. Daily values are shown on the left.
2. Cumulative values are shown on the right.
3. Dates are shown on the bottom.

— Cumulative Volume @ TotalCut @ Total Fill

Daily Volume (m?) Cumulative Volume (m?)
25K " " 100K
VT S 90K
20K — "’ 80K
70K
15K 60K
50K
10K 40K
30K
5K 20K
10K
o —
0 W —_ p— — = 0
& I"’&;G'-" I"’\26'lel"\?;a"-"gll"\%ge‘-'\\I"’\Q;G:"-"rz'\‘l\ia"-"{g"\iﬁ"-’\‘k\‘i@"-"6\\16"-’\6‘\16"-’\11‘\%;6"-’\6\\16\@J\Za‘(?f@\za‘(l\x\zeﬁ o

You can click a legend label to toggle Cut, Fill, and Cumulative bars on/off in the view. If, for
example, you are only being paid for cut volumes, simply remove fill from the chart and track
the daily cut quantities. If you are doing a landfill job, you can toggle cut off so you see only
fill volumes.

— Cumulative Volume @) Fetateat @ Total Fill
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The total volume is always listed at the top of the chart under the name.

Project Extents 06/01/17 - 06/22/18

"Project Progress Volumes

Total Volume: 95,820.9 m?3 | Total Fill: 57,980.7 m? | Total Cut: 37,840.1 m?

You can also filter by Daily or Weekly. Weekly combines the daily charts into weeks and
sums them.

DAILY =

— Cumulative Volume @ Total Cut Ll

Cumulativi  WEEKLY

100000

P —————————
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= B Trimble WorksOS Trimble Westminster Project % e

Custom 06/12/17 - 06/30/17

Trimble Westminster Project Progress Volumes

481.2 0 | Total Fill: 42,185.9 m* | Total Cut: 24,295

WEEKLY ~

— Ccumustevolume @ Toicut @ TotlFil

Cumulative Volume (m3)

70,000

35,000
60,000

000
50,000

25,000
40,000

20,000
30,000

5,000
20,000

10,000

0611917 - 06125117

Progress volumes weekly graph

You can also filter the view in the standard way, but filters for progress volumes are
independent from other Dashboard filters.

= B Trimble WorksOS Trimble Westminster Project 5 e

Custom 06/12/17 - 06/30/17 =0 ;
Trimble Westminster Project Progress Volumes Filters x
Total Volume: 65,432.5 m? | Total Fill: 41,276.2 m? | Total Cut: 24,156.3 m?
= oararts-oazon7
D=0 ==
— cumulaty W ClearAll
Daily Volume (m3) Date Range -~
Favorite Filters -
Design Boundary a
Q se AZ

14000
Trimble Bldg 2 - Finish Grade.ttm
12000
Trimble Bldg 2 - Finish Grade -1.5f¢

10000 .
Alignment -

8000 Custom Area -
6000

4000

2000

0612117 0613417 06114117 061517 06/16/17 061717 0618117 06119117 0620117 0621117 0622117 06123117 0624117 06125117 06/26/17 0612717 06128 Cancel T

Progress volume daily graph with filter panel
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= bTﬂmble WorksOS 11461-STX 151 Plant )

Project Extents 01/20/21 - 03/09/21 _—:0 &
Progress Volumes

Total Volume: 116,853.7 m® | Total Fill: 61,968.2 m* | Total Cut: 54,885.5 m?

diE 0 WEEKLY +

— cumstievolime @ Tomicut @ Tt Fil

Cumulative Volume (m?)

120,000

100,000

80,000
25,000
60,000

20,000

15,000
40,000

20,000

0112021 - 01724121 01125021 - 01731721 02001121 - 0200721 02108721 - 02114121 0211821 - 02721121 0212221 - 0212821 0310121 - 0307121 03108721 - 03109721

Progress volumes weekly graph
Scroll in/out to see a shorter or longer time period in the chart.

—
To specify an alternate time span, click the Global 2F Filters icon on the Actions bar at the

upper right. Se Date Range Filters > Custom

Filters X
Date Range a

Today Yesterday
Current Week
Previous Week

Project Extents ~ Custom

Custom Date Range

From

06/01/17 00:00 m

Note: The maximum project extents (date range) is 1000 days.
Tip: Save your custom data range as a Favorite to quickly apply it at any time.

To configure the cut and fill colors, as well as material density factors (shrinkage and
bulkage), click the More icon (ellipsis) and select Project Settings > Volume. The factors you
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set are reflected in the material volumes.

Cut/Fill Bulkage/Shrinkage

o 04 %

. 0.10 L SHRINKAGE:

GRADE

Grid View

Select the Grid View for a table of values with the exact cut, fill, total, and cumulative values
for every working day. You can also export this grid to an CSV file for greater data analysis
and visualization in Microsoft® Excel.

bTr|mb|e WorksOS Trimble Westminster Project H 0

Custom 06/12/17 - 06/30/17 = L] :
Trimble Westminster Project Progress Volumes Q sear

Total Volume: 65,432.5 m* | Total Fill: 41.276.2 m? | Total Cut: 24,156.3 m?

D E 9

pate ¥ Fill volume (m?) Day of the Week cut Volume (m?) Total Velume (m?) Cumulative Volume (m?) Cumulative Cut (m?) Cumulative Fill (m?)

619.4 Friday 1.7 631.1 65432.5 24,156.3 41,276.2
06/29/17 ) Thursday [} ) 64.801.5 24,1446 40,656.9
06/28/17 0 Wednesday o 0 64,801.5 24,1446 40,656.9
06/27/17 21210 Tuesday 18347 3,855.7 64,801.5 24,1446 40,656.9

6/26/17 2

6/2: sunday 20,15t 44
06/24, aturday [ 5 20,15¢ 44
06423 167.¢ iday 562.7 7 9 20,15¢ 44
6/2. Thursdar 4 8

Grid View Functions

You can drag-and-drop columns and sort by column headers.
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To toggle columns on/off in the Table Settings pane, click the Settings icon.

™ DALY ~

-
@
g
1]
w
1]
s
=
=

aq
v
X

= Date I &
= DayoftheWeek J @
= CutVolume I
= Fill volume I o
= Total Volume 1 &
= Cumulative Volume I @
= Cumulative Cut I &
= Cumulative Fill 1

= B Trimble WorksOS

Custom 06/12/17 - 06/30/17

Trimble Westminster Project Progress Volumes

Total Volume: 65,432.5 m* | Total Fill: 41,276.2 m* | Total Cut: 24,156.3 m*
i E 0
Date ¥ Filvolume(m)  DayoftheWeek  CutVolume(m?)  TotalVolume(m’)  Cumulative Volume (m?)
654325
Thursday 0 0 64,801.5
06/28/17 0 Wednesday s} 0 64,801.5
Tuesday 8347 39557 648015
ond 246.4 84!
unda
urday

Trimble Westminster Project

Cumulative Cut (m?) Cumulative Fill (m#)

Progress volumes grid view with Table settings

&
o}

o
o
B
5
»
@
2
=
S

@
]
X

Fill Volume

Day of the Week
Cut Volume

Total Volume
Cumulative Volume

Cumulative Cut

T R R I ]
8 8 8 8 8 8 8 8

Cumulative Fill

To export the grid values to CSV for more sophisticated data analysis, manipulation, and
visualization in Microsoft Excel, click the Exporticon.
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A B - D E F G H

1 lTrimbIe Westll'ninster Project Progress Volumes
2 Total Volume: 95,820.9 m? | Total Fill: 57,980.7 m? | Total Cut: 37,840.1 m?
3
4 Date Day of the Week Cut Volume (m?) Fill Volume (m?) Total Volume (m?) Cumulative Volume (m?) Cumulative Cut (m?) Cumulative Fill (m?)
5 6/22/2018 Friday 1.6 5.1 6.7 95,820.90 37,840.10 57,980.70
6 6/21/2018 Thursday 43.5 80.5 124 95,814.20 37,838.50 57,975.70
7 6/20/2018 Wednesday 0 0 0 95,690.20 37,795.00 57,895.20
8 6/19/2018 Tuesday 0 0 0 95,690.20 37,795.00 57,895.20
9 6/18/2018 Monday 69.8 52.9 122.7 95,690.20 37,795.00 57,895.20
10 6/17/2018 Sunday 0 0 0 95,567.50 37,725.20 57,842.30
11 6/16/2018 Saturday 0 0 0 95,567.50 37,725.20 57,842.30
12 6/15/2018 Friday 6.2 92.3 98.5 95,567.50 37,725.20 57,842.30
13 6/14/2018 Thursday 6.7 1.9 8.6 95,469.00 37,719.00 57,750.00
14 6/13/2018 Wednesday 0 0 0 95,460.40 37,712.30 57,748.00
15 6/12/2018 Tuesday 0 0 0 95,460.40 37,712.30 57,748.00
16 6/11/2018 Monday 243.5 82 325.6 95,460.40 37,712.30 57,748.00
17 6/10/2018 Sunday 0 0 0 95,134.80 37,468.80 57,666.00
18 6/9/2018 Saturday 0 0 0 95,134.80 37,468.80 57,666.00
19 6/8/2018 Friday 322.5 56 378.5 95,134.80 37,468.80 57,666.00
20 6/7/2018 Thursday 310.6 229.7 540.4 94,756.30 37,146.30 57,610.00
Map View

This view lets you see the areas your machines cut and filled geographically on the project
site.
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§ Trimble Westminster Project
BTrimble WorksOS A i g L

D Project Extents 06/01/17 - 09/01/27

@ Trimble MAPS  Trimbie Ine. | @ OpenMapTiles & Openstrstap eontributars

Map view

= BTrimble WorksOS e T D 2 0

Last 31 Days 03/22/22 - 04/21/22 OO0

Westminster Test Strip Progress Volumes

Total Volume: 3,103.3 ye? | Total Fill: 81.2 yd® | Total Cut: 3,022.2 yd®

ME e

Volume Information X Contributing Machines X

These are the machines that contributed 1o the
work completed between 03/22/22 and 04/21/22

Total Volume

3,103.3 yd® )

Total Fill

812yd Dynapac 2500D
Total Cut Cat308

3,022 yd?

Daily Average CAT D5K2

Cut: 159.1 yd®
Fill: 43 y
Total: 1633 yd®

Working Days
19

Weekly Average
Cut: 604.4 yd*

Fill: 16.2 yd®
Total: 6207 yd®
Working Weeks
5

Machines

3 contributing

View contributing machine list

Progress volumes Map view
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Map View Functions
To toggle certain types of data on/off in the Map Settings pane, click the Settings icon.
=k - I
Project Settings
Map Settings

Excluded Elevations

X

Map Settings

Alignments
Designs
Linework
Production Data
Cell Information

Devices

d vl

Drone Imagery
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Click the Volume Information arrow on the left side to see totals, including daily and weekly
averages.

o = 9

Volume Information b

Total Volume

Total Fill

Total Cut

Daily Average

i Y

Working Days

Weekly Average

i 27 T

C 7 7 me

Working Weeks

Note: Total Volume, Daily Average, and Weekly Average include both cut or fill, as
applicable.

Note: Any non-working (0 volume) days/weeks are excluded from the Daily/Weekly
Average.

Tip: Filter by new date ranges to see working areas and averages for specific time
periods. This can help you, for instance, identify seasonal productivity patterns.

Note: If you cut and fill the same volume during the same day, the change is net 0.0. If
you cut one day and fill the next day, there is a day-over-day change. Before WorksOS,
this was done based on load counts. In this case, progress is measured by looking at the
day-over-day change. There is usually an objective goal for how much to move (cut or fill)
each day.

When you have questions, your best source of help is the WorksOS Resource Center.
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https://community.trimble.com/community/find-answers/civil-engineering-and-construction/worksos

Getting Help and Support

For more helpful information, see Reaching Sales, Support, and Community.
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